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1
Foreword
About this Guide
This guide is intended for laboratory technicians who are responsible for control and day-to-day 
maintenance of the Eksigent MicroLC 200 Plus system. It is assumed that the user of this guide 
is familiar with standard laboratory terminology.

Symbols and Conventions
The following conventions are used throughout the guide.
l

Note: Read the safety instructions and the rest of this guide before using the Eksigent 
MicroLC 200 Plus system.

Table 1-1 Symbols and Descriptions

Pictorial Description
The danger sign warns about a hazard. It calls attention to a procedure or 
practice which, if not adhered to, could results in injury or loss of life.

Do not proceed beyond a danger sign until the indicated conditions are fully 
understood and met.

The warning sign denotes a hazard. It calls attention to a procedure or practice 
which, if not adhered to, could result in severe injury or damage or destruction 
of parts or all of the equipment.

Do not proceed beyond a warning sign until the indicated conditions are fully 
understood and met.

Caution:

The caution signal word denotes a hazard. It calls attention to a procedure or 
practice which, if not adhered to, could result in damage or destruction of parts 
or all of the equipment.

Do not proceed beyond a caution sign until the indicated conditions are fully 
understood and met.

The tip sign signals relevant information. Read this information, as it might be 
helpful.

The note sign signals additional information. It provides advice or a suggestion 
that may support you in using the equipment.

This symbol indicates that the waste of electrical and electronic equipment 
must not be disposed as unsorted municipal waste and must be collected 
separately. Please contact an AB SCIEX field service employee for 
information concerning the decommissioning of equipment.
Operator Guide Eksigent MicroLC 200 Plus System
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Foreword
Safety Instructions
The following safety instructions apply to the Eksigent MicroLC 200 Plus system:

Caution: Potential System Damage! Changes or modifications to this unit not expressly 
approved by the manufacturer could void the instrument warranty and render the system 
inoperable.

WARNING! Personal Injury Hazard: Use of this equipment in a manner not 
approved by the manufacturer may inhibit its safety protection.

WARNING! Electrical Shock Hazard: Only use fuses of the type and current 
rating specified. Do not use repaired fuses or by-pass the fuse holder.

WARNING! Electrical Shock Hazard: The supplied power cord must be used with 
a power outlet containing a protective ground contact.

WARNING! Biohazard: When replacing tubing or fittings on the Eksigent 
MicroLC 200 Plus system, exposure to solvents may occur. It is therefore 
recommended that appropriate safety procedures be followed and personal 
protective equipment be used, according to the applicable Safety Data Sheets 
supplied by the solvent vendor.

WARNING! Electrical Shock Hazard: Do not change the external or internal 
grounding connections. Tampering with or disabling these connections could 
create a safety hazard and/or damage the system. The instrument, as shipped, is 
properly grounded in accordance with normal safety regulations.

WARNING! Electrical Shock Hazard: Do not turn the system on if you suspect 
that it has incurred any kind of electrical damage. Instead, disconnect the power 
cord and evaluate the system.

WARNING! Electrical Shock Hazard: Electrical damage may have occurred if any 
part of the system shows visible signs of damage, exposure to liquids or of 
having been transported under severe stress.

WARNING! Electrical Shock Hazard: Continue to exercise caution as capacitors 
inside the system may still be charged even after the system has been turned off.

WARNING! Electrical Shock Hazard: Disconnect power cords from the power 
supply before attempting any type of maintenance.
Eksigent MicroLC 200 Plus System Operator Guide
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Foreword
Caution: Potential System Damage: Damage can result if the system is stored for 
prolonged periods under extreme conditions (for example, subjected to heat, water, etc.)

Caution: Potential System Damage: To avoid damaging electrical parts, do not 
disconnect an electrical assembly while power is applied to the system. Once the power is 
turned off, wait approximately 30 seconds before disconnecting an assembly.

Caution: Potential System Damage: The system contains a number of sensitive 
electronic components that may be damaged if exposed to excessive line voltage 
fluctuations and/or power surges.

Caution: Potential System Damage: An on-board lithium battery maintains the 
autosampler firmware when the instrument is turned off. It should only be replaced by a 
factory-authorized service engineer.

WARNING! Electrical Shock Hazard: The combination of the pump and 
autosampler with a LC/MS system may require additional safety measures as 
described by AB SCIEX. Refer to the mass spectrometer Safety Guide or System 
User Guide for instructions for the safe grounding on the LC/MS system.

WARNING! Electrical Shock Hazard: Use a grounding cable connected between 
the injection valve's sample loop and an appropriate grounding point at the 
LC/MS source. This supplementary grounding will reinforce the safety 
configuration specified by AB SCIEX.

WARNING! Environmental Hazard: Do not allow flammable and/or toxic solvents 
to accumulate. Follow a regulated, approved waste disposal program. Never 
dispose of flammable and/or toxic solvents into a municipal sewage system.

WARNING! Puncture Hazard: To avoid injury during operation, keep hands and 
loose objects away from the autosampler arm and syringe assembly.

WARNING! Personal Injury Hazard: Use caution when working with any 
polymeric tubing under pressure:
– Always wear proper eye protection when near pressurized polymer tubing.
– Do not use polymer tubing that has been severely stressed or kinked.
– Do not use polymer tubing, in particular PEEK or DuPont Tefzel tubing, with 
tetrahydrofuran (THF), dimethylsulfoxide (DMSO), chlorinated organic solvents, 
concentrated mineral acids, such as nitric, phosphoric or sulfuric acids, or any 
related compounds.

WARNING! Puncture Hazard: Do not operate the autosampler without the safety 
shield properly installed.
Operator Guide Eksigent MicroLC 200 Plus System
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Foreword
Caution: Potential Data Corruption: When you use the HTC-xt PAL autosampler for 
chromatographic analyses and observe a change in the retention of a particular 
compound, the resolution between two compounds or peak shapes, immediately 
determine the reason for the changes. Do not rely on the analytical results until the cause 
of the change is determined.

Qualified Personnel
After installing the system, the Field Service Employee (FSE) uses the Customer Familiarization 
Checklist to familiarize the customer on system operation, cleaning, and basic maintenance. 
Only AB SCIEX qualified personnel shall install, operate, and maintain the equipment. 
Equipment service shall only be conducted by AB SCIEX FSEs. Contact an AB SCIEX FSE for 
more information.

Equipment Use and Modification
Use the system indoors in a laboratory that complies with the environmental conditions 
recommended in the Site Planning Guide. If the system is used in an environment or in a manner 
not prescribed by AB SCIEX, the protection provided by the equipment can be impaired.

Unauthorized modification or operation of the system may cause personal injury and equipment 
damage, and may void the warranty. Contact an AB SCIEX representative for more information 
on servicing the instrument.

Regulatory Compliance
This system complies with the standards and regulations listed in this section. Applicable labels 
have been affixed to the system. For more information, see the Declaration of Conformance 
included with the system.

Canada

• Safety—CAN/CSA C22.2 No. 61010-1

Europe

• Electromagnetic Compatibility—EN 55011 Class A and EN 61326-1

• Safety—EN 61010-1

• WEEE—2002/96/EEC

USA

• Safety—UL 61010-1

International

• Electromagnetic Compatibility—CISPR 11 Class A, IEC 61326-1

• Safety—IEC 61010-1
Eksigent MicroLC 200 Plus System Operator Guide
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Foreword
Symbols and Labels

System Disposal (Waste Electrical and Electronic 
Equipment)
Do not dispose of system components or subassemblies, including computer parts, as unsorted 
municipal waste. Follow local municipal waste ordinances for proper disposal provisions to 
reduce the environmental impact of WEEE (waste, electrical, and electronic equipment). To 
make sure that you safely dispose of this equipment, contact an FSE for instructions. 

European Union customers: Contact a local AB SCIEX Customer Service office for 
complimentary equipment pick-up and recycling.

Table 1-2 Labels on the Eksigent MicroLC 200 Plus System

External Labels Definition
WARNING: Use only the original power supply.

Caution: Risk of needle-stick puncture.

Caution or Refer to the Operator Guide.

WARNING: Flush Gas. Refer to the Operator 
Guide for instructions on using a purge gas with 
the stack cooler.

Do not dispose of equipment as unsorted 
municipal waste (WEEE).

Direct Current

A Amperes (current)

V Volts (voltage)

V-A Volts - Amperes (power)
Operator Guide Eksigent MicroLC 200 Plus System
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Foreword
Related Documentation
• PAL Installation and Operation User Manual—contains detailed information about 

the autosampler. Printed and electronic copies are included.

• Eksigent Control Software User Guide—installed with the Eksigent control software

• Analyst® Software Getting Started Guide or System User Guide—installed with the 
Analyst software

Technical Support
AB SCIEX and its representatives maintain a staff of fully-trained service and technical 
specialists located throughout the world. They can answer questions about the instrument or any 
technical issues that may arise. For more information, visit the web site at www.absciex.com. 
Eksigent MicroLC 200 Plus System Operator Guide
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2
Introduction
The benefits of micro high-pressure liquid chromatography (HPLC) —high sensitivity, fast 
separations and reduced solvent consumption—can be achieved with careful attention to certain 
key operating procedures. There are subtle but important differences between liquid 
chromatography separations performed using 300 µm or 500 µm ID columns and those using 
2.1 mm ID columns. This manual describes the basic operation and critical parameters to 
consider for routine and robust operation of the Eksigent MicroLC 200 Plus system.

System Description

The system includes:

• Binary gradient pumping system, with two flow rate configurations:

• 5 µL/min to 50 µL/min

• 20 µL/min to 200 µL/min

• Eksigent control software

• Eksigent system accessory kit, with three sample loops (2 µL, 5 µL, and 10 µL) a 
column, fittings, and other supplies (refer to System Accessory Kit on page 129)

• CTC Analytics HTC-xt PAL autosampler, including:

• 3-drawer cooling stack holder (additional options available)

Figure 2-1 Eksigent MicroLC 200 Plus System
Operator Guide Eksigent MicroLC 200 Plus System
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Introduction
• Dynamic load and wash feature (DLW) (refer to Dynamic Load and Wash on 
page 111)

• PAL Loader software

• Object Manager software

• User documentation

• Column oven

Accessory Options
Depending upon the system you purchase, your system will have either:

• Column oven mounting kit (PN 5017397)

or

• AB SCIEX mass spectrometer interface kit (PN 801-00084), including:

• 65 µm stainless steel electrode (PN 5029342) 

• Column oven mounting kit (PN 5015996)

• Clamp and rod assembly (PN 5016951) 

• Grounding kit (PN 5016941)

• MS interface cable (PN 700-0049)
Eksigent MicroLC 200 Plus System Operator Guide
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3
Using the System
This chapter offers a brief tutorial on the use of the Eksigent MicroLC 200 Plus system, using 
either the Analyst® software or the Eksigent control software. The procedures described in this 
chapter assume the system has already been properly installed and initialized.

The Example Experiment
The experiment consists of two samples, each injected three times on the 5 cm HALO fused-core 
C18 column installed with the system. The sample runs are followed by one injection of a blank 
sample (50:50 water:acetonitrile) to flush the electrode. The instructions below assume a 2 µL 
sample loop is installed on the system and the column is heated to 35°C. 

The mobile phases are water and acetonitrile. The aqueous channel for the pump (Channel A) 
will be filled with Mobile Phase A. The organic channel (Channel B) will be filled with Mobile 
Phase B, shown in Table 3-1. 

Each run is one minute and has a gradient from 90% to 10% water, except for the final run to 
flush the electrode, which is 20 minutes and is isocratic 50% water and 50% acetonitrile.

Guidelines for Sample Preparation
For the best results with the Eksigent MicroLC 200 Plus system, follow the guidelines below for 
sample preparation.

The flow path can clog if samples contain too much particulate matter. 

• Use HPLC- or MS-grade solvents at all times. 

• Avoid the use of non-volatile salts and buffers such as CHAPS, phosphate, TRIS, 
HEPES and perchlorates. These additives will foul the electrospray source and 
mass spectrometer orifice.

• Avoid overloading the column with sample. 

• For 0.3 mm and 0.5 mm ID columns—use <12 µg of material 

• For 1 mm ID columns—use <50 µg of material

• AB SCIEX recommends pre-filtering samples with 0.45 µm pore filters to avoid 
particulate contaminants which may cause clogging.

• If needed, centrifuge all samples at 10 000 RPM for 5 minutes to remove dust and 
particulates from the sample solution.

• If sample filtration is not sufficient, the following techniques can be used: 

• Protein precipitation (for biological samples)

Table 3-1 Mobile Phases for the Example Experiment

Mobile Phase Mixture Channel
Mobile Phase A 100% water:0.1% formic acid Channel A

Mobile Phase B 100% acetonitrile:0.1% formic acid Channel B
Operator Guide Eksigent MicroLC 200 Plus System
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Using the System
• Liquid-liquid extraction 

• Solid-phase extraction

• Addition of an in-line filter or guard column to the flow path (refer to Table C-4 
on page 132 for part numbers)

Perform a Run Using the Analyst Software
The following instructions walk through the example experiment using the Analyst software. Use 
these instructions when using the mass spectrometer and the Eksigent MicroLC 200 Plus system 
as an integrated system.

These instructions assume you are familiar with the Analyst software. For more information, refer 
to the Analyst® Software Getting Started Guide or the System User Guide, available from the 
Start menu.

Complete the following steps in the order they appear:

1. Verify the Analyst Software Hardware Profile.

2. Load the Mobile Phases.

3. Flush the Injection Valve.

4. Enable the Column Oven.

5. Equilibrate the Eksigent MicroLC 200 Plus System.

6. Create the LC Methods.

7. Create the Acquisition Methods and the Batch.

8. Submit the Batch.

9. Monitor the Run.

Verify the Analyst Software Hardware Profile
The active hardware profile must include the autosampler and the Eksigent control software to 
perform a run using the Analyst software. The FSE should configure your system for you, but if 
you are using a different computer or have uninstalled the Analyst software, the hardware profile 
may not be correct.

1. Start the Analyst software.

2. On the Navigation bar, under Configure, double-click Hardware Configuration.
Eksigent MicroLC 200 Plus System Operator Guide

16 of 140 RUO-IDV-05-1129-B | D5033433 G



Using the System
3. In the Hardware Configuration Editor dialog, click each hardware profile to open it 
and locate a profile that contains a mass spectrometer, the autosampler, and the 
Eksigent control software as shown in Figure 3-1.

If an appropriate profile does not exist, create a profile as described in Create a 
Hardware Profile on page 19.

4. If the profile does not have a green check to the left, click Activate Profile.

Figure 3-1 Hardware Profile Configured for the Eksigent MicroLC 200 Plus 
System
Operator Guide Eksigent MicroLC 200 Plus System
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Using the System
The active profile appears with a check, the Eksigent control software launches and 
the Eksigent control software Acquisition window appears (Figure 3-2).

If the Acquisition window does not appear (indicating that the Eksigent control 
software did not start) do the following:

a. Close the Analyst software.
b. Select Start > Programs > Eksigent > Driver Configuration.
c. Uninstall, and then reinstall the Analyst software drivers.
d. Restart the Analyst software.

i

Figure 3-2 Acquisition Window, Showing the LC Methods Button

Note: Do not start the Eksigent control software manually. Instead, allow the Analyst 
software to start the Eksigent control software. (When the Eksigent control software is 
launched independently, the “LC Methods” button appears as “Run Manager”.)
Eksigent MicroLC 200 Plus System Operator Guide
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Using the System
 Create a Hardware Profile

1. Click New Profile to open the Create New Hardware Profile dialog (Figure 3-3).

2. Type a name for the profile in the Profile Name field.

3. Add the autosampler.

a. Click Add Device to open the Available Devices dialog (Figure 3-4).

Figure 3-3 Create New Hardware Profile Dialog

Figure 3-4 Available Devices Dialog, Showing Autosamplers
Operator Guide Eksigent MicroLC 200 Plus System
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Using the System
b. Select Autosampler in the Device Type list, click AutoSampler CTC PAL 
and then click OK.

c. Click Setup Device to open the CTC PAL dialog (Figure 3-5). 
d. Type a volume in the Valve Loop Volume field.

e. Click Configure and select the appropriate COM port.
f. Click OK.

4. Click Add Device to add the Eksigent control software.

a. Select Software Application in the Device Type list, then click Software 
Application <not configured>.

b. Click OK.
c. Click Setup Device to open the Software Application Settings dialog 

(Figure 3-6). 
d. Click Eksigent 1 and then click OK.

Note: A 2 µL loop should be installed on the system. Enter a value 
between 5 µL and 100 µL in this field. The value is logged in the data file but 
does not affect the run. Future releases of the Analyst software will support 
smaller loop volumes (for example, 2 µL).

Figure 3-5 CTC PAL Dialog
Eksigent MicroLC 200 Plus System Operator Guide
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Using the System
5. Click Add Device to add the mass spectrometer.

a. Select Mass Spectrometer in the Device Type list.
b. Click the appropriate mass spectrometer in the list and then click OK.

6. Click OK to save the profile and close the Create New Hardware Profile dialog

Load the Mobile Phases
For additional information about mobile phases for the Eksigent MicroLC 200 Plus system, refer 
to Recommendations for Mobile Phases on page 23.

1. Pour new mobile phase into the bottles, then insert the mobile phase transfer tubing 
and filters.

2. Specify the mobile phase information in the Eksigent control software.

a. Click System > Mobile Phases to open the Mobile Phases dialog 
(Figure 3-7).

b. For Binary Mixture A (mobile phase A), do not make any changes. 
c. For Binary Mixture B (mobile phase B), select Acetonitrile in the lower list and 

type 100 in the % field.
d. (Optional) Type any comments in the Comments/Modifiers fields.

Figure 3-6 Software Application Settings Dialog

Tip! The correct instrument is usually highlighted in the list.
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Using the System
3. Purge the pumps a minimum of 20 times.

a. Click More to display additional options in the dialog.
b. In the Purge Settings section, select the pumps to be purged and set purge 

cycles to 20 (Figure 3-8). 

c. Click Purge Now.
The pumps begin to execute purge cycles. While the pumps are purging, 
make sure the mobile phases are pulled through the mobile phase tubing to 
the pumps.

d. Locate the waste tubing of the pumps being purged (the waste tubes are clear 
plastic tubing and emerge from the rear of the pump). After about 8 purges, 
the mobile phase should be purged through the waste tubing. 

4. Flush the system.

a. In the Flush Settings section, type 500 µL for the Total Volume (Figure 3-9).
b.  Set the Flush Flowrate based the configuration:

– Type 50 µL/min for the low-flow configuration.
– Type 100 µL/min for the high-flow configuration.

Figure 3-7 Mobile Phases Dialog—Settings for the Example Experiment

Note: If a mobile phase that is not listed in the Mobile Phases dialog is 
required for your experiment, either select a mobile phase from the list with a 
very similar viscosity or add a new one. Refer to Use a Custom Mobile Phase 
for instructions.

Figure 3-8 Purge Settings Section of the Mobile Phases Dialog 
Eksigent MicroLC 200 Plus System Operator Guide
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Using the System
c. Connect one end of a length of 1/32 inch OD tubing to the mobile phase outlet 
on the front of the pump and insert the other end in a waste vial. 

Caution: Potential System Damage: Make sure that no LC columns are 
connected before proceeding with this operation. Flushing the system with a 
column connected could over-pressure the system and create leaks.

d. Click Flush Now. 
e. When the flush sequence ends, click OK to close the dialog.

Recommendations for Mobile Phases

Mobile phases should be compatible with the following materials: 316L stainless steel, PTFE, 
FEP, PEEK, sapphire, glass, and fused silica. Some compatible solvents include water, 
acetonitrile, methanol, ethanol, n-propanol, isopropanol, hexane, heptane.

Use a Custom Mobile Phase

Some experiments require a mobile phase other than those available in the Eksigent control 
software. Add a custom mobile phase in the Mobile Phases dialog. Also, if you are using a 
mixture of two solvents in one bottle, create a custom mobile phase for the mixture.

1. Click System > Mobile Phases to open the Mobile Phases dialog.

2. Click More to show more options in the dialog (Figure 3-10).

Figure 3-9 Flush Settings Section of the Mobile Phases Dialog—Settings for 
High-flow Configuration

Required Materials
• Calibration kit (with 100 µL and 200 µL pipettes) (PN 5018262)
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Using the System
3. In the Mobile Phase Change section, click Create New Fluid to open the 
Flowmeter Calibration dialog.

4. Follow the steps in the Flowmeter Calibration dialog. 

Adding a custom mobile phase includes performing a flowmeter calibration. For the 
calibration, select the calibration pipette based on the system configuration:

• Low-flow configuration—100 µL

• High-flow configuration—200 µL

Flush the Injection Valve
Flush the valve when the column is not connected to prevent introducing any contaminants from 
the valve to the column.

1. Make sure that the column is not connected.

2. Click System > Direct Control in the Eksigent control software to open the Direct 
Control dialog (Figure 3-11).

3. In the Pump Direct Control section, select the Conserved Flow option and set 
both A (%) and B (%) to 50. 

4. Set the Total flowrate to 20 µL/min.

Figure 3-10 Mobile Phases Dialog—Expanded

Tip! You can also open the Direct Control dialog by clicking  (Direct 

Control) in the Acquisition window.
Eksigent MicroLC 200 Plus System Operator Guide
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5. Click Start.

6. In the Valve Direct Control section, alternate clicking Load Position and Inject 
Position, waiting ~ 10 seconds between each click.

7. Perform step 6 twice more.

8. Click Load Position, then click Stop.

Enable the Column Oven
The temperature of the column compartment can be regulated, with a maximum temperature of 
80°C.

1. Connect the column.

2. Click System > Direct Control in the Eksigent control software to open the Direct 
Control dialog.

3. In the Column Oven/Heater section, type 35 in the Setpoint field (Figure 3-12).

Figure 3-11 Direct Control Dialog

Tip! When reconnecting the column, follow the tips in Best Practices for 
Working with PEEKsil Tubing on page 62 to prevent crushing the PEEKsil 
tubing and potentially clogging the system.
Operator Guide Eksigent MicroLC 200 Plus System
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Using the System
4. Click Start.

The oven will come to temperature quickly, however the column can take up to 30 
minutes to stabilize to the oven temperature.

Equilibrate the Eksigent MicroLC 200 Plus System
1. Make sure that the LC column is connected.

2. Click System > Direct Control in the Eksigent control software to open the Direct 
Control dialog (Figure 3-13).

3. In the Pump Direct Control section, select the Conserved Flow option and set A 
(%) to 90 and B (%) to 10. 

This is the mobile phase composition used for equilibration.

4. Set the Total flowrate based on the configuration:

Figure 3-12 Direct Control Dialog—Column Oven/Heater Section

Note: Do not operate the oven for an extended period of time without 
closing the compartment.
Eksigent MicroLC 200 Plus System Operator Guide
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Using the System
• Type 50 µL/min for the low-flow configuration

• Type 150 µL/min for the high-flow configuration.

5. Click Start to begin equilibration.

6. Allow the system to equilibrate for approximately 10 minutes, then click Stop.

7. Click Close.

Create the LC Methods
An LC method contains the conditions used for separating the sample, including flow rate, flow 
mode, and mobile phase gradient. 

The Eksigent MicroLC 200 Plus system has two flow modes:

• Conserved—you set the concentration and total flow rate and the system calculates 
the flow rate for each mobile phase.

• Independent—you set the flow rate for each mobile phase and the system 
calculates the total flow rate.

For the example experiment, two LC methods are required, a gradient for separating the sample 
and an isocratic method for flushing the system at the end of the batch or sequence.

Figure 3-13 Direct Control Dialog—Settings for High-flow Configuration

Note: To avoid conflicts with the Analyst software after the system has 
equilibrated, be sure to click Stop to end pumping and then close the Direct 
Control dialog.
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Create the Separation Method

This section creates a gradient LC method called “Analysis Test”. 

1. Click LC Methods to display the LC Method Settings dialog.

2. In the Name box, type “Analysis Test” as the name for the method, and then click 
Save.

3. In the Column Information section, specify the values as shown in Figure 3-14.

Figure 3-14 LC Methods Settings Dialog—Summary Tab
Eksigent MicroLC 200 Plus System Operator Guide
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Using the System
4. Click Run Conditions tab and specify the values shown in Figure 3-15.
 

The duration of the flow in the Flush the column for field should allow to 3 to 5 
column volumes to pass through the system between runs. Depending on your 
experiment, a greater volume may be required.

When the Stabilize column temperature check box is selected, the run does not 
begin until the column reaches the specified temperature ±0.1°C.

There are four modes of sample injection. They differ in whether the sample loop 
stays in-line during the acquisition and how much of the contents of the sample loop 
is transferred to the column.

• None—the sample valve does not actuate during the acquisition.

• Standard—the sample valve moves to the inject position when acquisition 
begins and returns to the load position when acquisition ends. The sample 
loop remains in the flow path during acquisition.

• Metered—the valve switches to the inject position when acquisition starts and 
the specified volume of sample is delivered to the column by the LC pumps at 
the specified flow rate. After the specified volume is injected, the sample valve 
switches to the load position, removing the sample loop from the flow path. 

Figure 3-15 LC Method Settings Dialog—Run Conditions Tab
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Using the System
The minimum injection volume (in nanoliters) is given by 2.5 x Q, where Q is 
the flow rate. 
Use metered injection when the sample loop volume is larger than the volume 
to be injected on the column. With metered injection, the large sample loop 
doesn’t add any extra dead-volume, preventing extra-column broadening. 

• Rapid—the valve operates as during metered injection, except the LC pumps 
increase the flow rate during the injection in order to inject the sample quickly 
and prevent broadening.

5. Click Gradient Table to set the flow mode, the gradient parameters, and the flow 
rate (Figure 3-16). 

 

6. (Optional) To set additional events, such as valve switching and peak parking, type a 
Time and then select an event from the list in the Event cell. 

Note: AB SCIEX does not recommend metered or rapid injection for 
quantitative experiments.

Figure 3-16 LC Method Settings Dialog—Gradient Table Tab
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Using the System
7. Click Gradient Profile to view a graphical representation of the gradient (Figure 3-
17).

The last two steps in the method allow for the weaker solvent to flow through the 
sample loop before the next sample is injected.

Alternately, specify the gradient and event information in this tab:

a. Click the blue line to add a time point.
b. Drag the point to the mobile phase % for that time.

The % for the other mobile phase adjusts automatically.
c. (Optional) Edit the % or min field to describe the change more exactly.
d. (Optional) Right-click the gradient profile to set additional events. Click and 

drag the event right or left to change its time.

8. Click Save, then click OK.

Figure 3-17 LC Method Settings Dialog—Gradient Profile Tab
Operator Guide Eksigent MicroLC 200 Plus System

RUO-IDV-05-1129-B | D5033433 G  31 of 140



Using the System
Create the Electrode Flush Method

This section creates an LC method that is used to flush the ESI electrode after the samples have 
been run. The method flushes the system for 20 minutes with a 50:50 mixture of mobile phases A 
and B.

1. Click LC Methods to display the LC Method Settings dialog.

2. In the Name box, type a name for the method, such as “Electrode Flush” and then 
click Save.

3. Click Run Conditions tab and specify the values shown in Figure 3-18.
 

Figure 3-18 LC Method Settings Dialog—Run Conditions Tab
Eksigent MicroLC 200 Plus System Operator Guide

32 of 140 RUO-IDV-05-1129-B | D5033433 G



Using the System
4. Click Gradient Table to set the flow mode, the gradient parameters, and the flow 
rate (Figure 3-19). 

 

Figure 3-19 LC Method Settings Dialog—Gradient Table Tab
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5. Click Gradient Profile to view a graphical representation of the gradient (Figure 3-
20).

6. Click Save, then click OK.

Create the Acquisition Methods and the Batch
The instructions below assume familiarity with the Analyst software. For more information, press 
F1 to view the help or refer to the Analyst® Software Getting Started Guide or the System User 
Guide available from the Start menu or the Customer Reference DVD.

For the example experiment, two acquisition methods are needed, one for the samples and one 
to flush the electrode after the samples have been run.

Create the Acquisition Method for the Sample Data

1. On the Navigation bar, under Acquire, double-click Build Acquisition Method to 
create the acquisition method.

2. Select the mass spectrometer method.

a. In the Acquisition Method window, click Mass Spec.

Figure 3-20 LC Method Settings Dialog—Gradient Profile Tab
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b. Specify the parameters for the mass spectrometer acquisition. 
c. Click Edit Parameters to set the Source/Gas parameters.

The parameters appropriate for micro-LC are different than for conventional 
liquid chromatography. Use the values in Figure 3-21 as a starting point and 
determine more optimal settings. 

For flow rates between 5 µL/min and 30 µL/min, these settings should be 
close to optimal. For higher flow rates, the temperature, curtain gas, GS1, and 
GS2 are typically higher, and the ion spray voltage is lower. Refer to Table 3-2 
for suggested values.

Figure 3-21 Initial Values for Source/Gas Parameters 

Table 3-2 Source/Gas Parameters for 5 µL/min to 200 µL/min Flow Rates

Parameter Suggested Ranges
Curtain Gas (CUR) 10 to 30

Ion Source Gas 1(GS1) 15 to 40

Ion Source Gas 2 (GS2) 15 to 50

Temperature (TEM) 150 to 400

Ion Spray Voltage (ISV) 4500 to 5000

Tip! Higher temperatures can lead to clogged electrodes on the mass 
spectrometer. As appropriate, use lower temperatures for your experiments.
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d. Click OK to save the source and gas parameters.

3. Select the autosampler method.

a. In the Acquisition Method window, click CTC PAL Autosampler.

b. Select microLC200-Injection-Rev B in the Available Cycles list.
Refer to Autosampler Method on page 115 for more information about the 
method. 

4. Set parameters for the autosampler method.

a. Select 100ulDLW in the Syringe list.
b. In the Injection Volume field, type 10.

Refer to About the Volumes in the Autosampler Method on page 38.
c. In the Cycle Arguments table, type 1 for both Front Volume and Rear 

Volume.
d. In the Cycle Arguments table, select Wash2 for Second Wash Solvent. 

Figure 3-22 CTC Autosampler Basic Properties Tab in the Acquisition Method 
Window, Showing microLC200-Injection-Rev B

Note: The autosampler method installed with the Eksigent MicroLC 200 
Plus system may have a different name than listed above. Use the most 
recent autosampler method supplied by AB SCIEX. 
Eksigent MicroLC 200 Plus System Operator Guide
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The parameters for this method (after making the edits above) are shown in 
Table 3-3. 

5. Select the LC Method.

a. In the Acquisition Method window, click Eksigent 1 (Figure 3-23).

Note: When entering values less than 1, the Cycle Arguments table does 
not accept a zero before the decimal point. To enter a number less than 1, 
type a period and then the number.

Table 3-3 Parameters for the Autosampler Method

Parameter Value Parameter Value
Airgap Volume (µL) 1 Valve Clean Time 1 (s) 5

Front Volume (µL) 1 Needle Clean Time 1 (s) 2

Rear Volume (µL) 1 Second Wash Solvent Wash2

Sample Aspirate Speed (µL/s) 2 Needle Clean Time 2 (s) 2

Pullup Delay (ms) 500 Valve Clean Time 2 (s) 5

Num of Wash1 PreDips 1 Replicate Count 1

Num of Wash2 PreDips 0 Final Wash Solvent Wash1

Inject to LCVlv1 0 or 1 Final Cleans 0

Injection Speed (µL/s) 1 Final Needle Clean Time (s) 2

Needle Gap for Vlv Cleans (mm) 0 Final Valve Clean Time (s) 5

First Wash Solvent Wash1

Figure 3-23 Acquisition Method—Selecting the LC Method
Operator Guide Eksigent MicroLC 200 Plus System

RUO-IDV-05-1129-B | D5033433 G  37 of 140



Using the System
b. In the Software Application Properties tab, click ... (Browse) to view the 
available LC methods. 

c. Click Analysis Test and then click Open.

6. Click File > Save, type Example Method for the name of the method.

Create the Acquisition Method for Flushing the Electrode

This method is used at the end of the batch to flush the electrode. Use the method above as a 
starting point with the following changes:

1. Select the mass spectrometer method created above.

2. Click File > Save As and type Electrode Flush Method for the name of the method.

3. Edit the mass spec parameters to lower the source temperature.

a. In the Acquisition Method window, click Mass Spec.
b. Click Edit Parameters to set the Source/Gas parameters.
c. In the Temperature (TEM) field, type 75.

d. Click OK to save the source and gas parameters.

4. Select the LC Method.

a. In the Acquisition Method window, click Eksigent 1.
b. Click ... (Browse) to view the available LC methods. 
c. Click Electrode Flush and then click Open.

5. Click File > Save.

About the Volumes in the Autosampler Method

• The Loop Volume fields (item 1) indicates the volume of the sample loop installed 
on the injection valve. This number is entered during installation, when the Analyst 
software hardware profile is created. These volumes are not used in the method.

• The Injection Volume field (item 2) is the volume aspirated by the autosampler 
needle for loading in the loop. The recommended volume for this field is 2 to 5 times 
the sample loop volume. 

Figure 3-24 CTC Autosampler Basic Properties Tab, Detail 

Item Description
1 Loop Volume field

2 Injection Volume field

1

2
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• For standard injection mode, the volume of the sample injected on the column 
is determined by the volume of the sample loop. 

• For other injection modes, the volume of the sample injected on the column is 
specified in the Sample Injection section of the LC Method Settings dialog 
(Figure 3-15).

Create the Acquisition Batch

1. On the Navigation bar, under Acquire, double-click Build Acquisition Batch to 
create the Acquisition Batch.

2. Specify the required information in the Samples tab of the Batch Editor window.

a. In the Set field, type Test Table and then click Add Set.
b. Click Add Samples and add a sample named “Control” with Number set to 3.
c. Repeat step b and add a second sample named “10 minutes”.
d. Select Example Method (the acquisition method you created above) in the list 

in the Acquisition section (Figure 3-25).

e. For each sample in the table, click Plate Code and select VT54 from the list 
(Figure 3-26).

3. Add the blank sample for the flushing the electrode.

a. Click Add Samples and add a sample named “Flush” with Number set to 1.
b. Select Electrode Flush Method (the method created above) in the list in the 

Acquisition section.
c. Click Plate Code and select VT54 from the list.

Submit the Batch
1. Place the sample vials in positions 1 and 2 of tray 1 of the autosampler. 

2. Place a vial containing the blank (50:50 water:acetonitrile) in position 3.

3. Click the Submit tab of the Batch Acquisition dialog, then click Submit to add the 
samples to the queue.

Figure 3-25 Acquisition Section—Selecting the Acquisition Method

Figure 3-26 Sample Table—Selecting the Plate Code
Operator Guide Eksigent MicroLC 200 Plus System

RUO-IDV-05-1129-B | D5033433 G  39 of 140



Using the System
4. Click  (View Queue) in the toolbar to open the Queue Manager (Local) dialog.

5. Click  (Equilibrate) to equilibrate the Eksigent MicroLC 200 Plus system and the 
mass spectrometer.

6. When the equilibration is finished, click  (Start Sample) to begin the run.

Monitor the Run
View the LC chromatogram and spectral data in Explore mode in the Analyst software. 

View flow rate and pressure information in the Acquisition window of the Eksigent control 
software (Figure 3-35 and Figure 3-36).

Figure 3-27 Batch Acquisition Dialog—Submit Tab
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Perform a Run Using the Eksigent Control 
Software
The following instructions demonstrate an example experiment using the Eksigent control 
software independently from the Analyst software. 

Use these instructions when:

• the Eksigent MicroLC 200 Plus system is not connected to a mass spectrometer 
(you are using a different type of detector)

or

• you are using the mass spectrometer as a standalone detector

Complete the following steps in the order they appear:

1. Turn on the System.

2. Prepare the Eksigent MicroLC 200 Plus System.

3. Create the LC Methods.

4. Create the Run Table.

5. Start the Run.

6. Monitor the Run.

For more information, refer to the Eksigent Control Software User Guide, installed with the 
software.

Turn on the System
1. If the system is not already on, turn on the power switch on the autosampler power 

supply.

2. Turn on the computer and start the Eksigent control software.

Prepare the Eksigent MicroLC 200 Plus System
1. Load the mobile phases.

Refer to Load the Mobile Phases on page 21.

2. Flush the injection valve.

Refer to Flush the Injection Valve on page 24.

3. Enable the column oven.

Refer to Enable the Column Oven on page 25.

4. Equilibrate the system.

Refer to Equilibrate the Eksigent MicroLC 200 Plus System on page 26.

Tip! For more information about the Eksigent control software, click 
Help > Help.
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Create the LC Methods
1. In the Acquisition window of the Eksigent control software, click Run Manager.

2. In the Run Manager window, click LC Methods.

3. Follow the instructions in Create the Separation Method on page 28, starting with 
step 2 to create an LC method named “Analysis Test”.

4. Follow the instructions in Create the Electrode Flush Method on page 32 to create 
an LC method named “Electrode Flush”.

Create the Run Table
The run table links an autosampler method, an LC method, and an analysis method to a sample 
vial and tray. You can also add descriptive information related to the sample or analysis. Each 
row in the run table represents one sample injection (unless the Replicates cell is >1).

Autosampler methods contain the parameters used for loading the sample into the injection valve 
and for rinsing the autosampler syringe and injection port. The autosampler method used below 
is optimized for the DLW option on the autosampler.

1. Click Edit > Erase Table to create a new run table.

2. Click File > Save As, type Test Table in the File name field, and then click Save to 
create a template for a new run table. 

The name of the run table appears in the upper left corner of the window 
(Figure 3-28).

3. Specify the information for the first injection of the first sample.

a. In the first line of the run table, double-click the Autosampler Method cell and 
select microLC200-Injection-Rev B from the list (Figure 3-29). 

Figure 3-28 Run Manager Window, Showing Table Name

Note: The autosampler installed with the Eksigent MicroLC 200 Plus 
system may have a different name than listed above. Use the most recent 
autosampler method supplied by AB SCIEX. 
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The software automatically sets Tray and Vial to 1. 
b. Double-click the LC Method cell and select Analysis Test. 
c. Type Control in the Sample Name cell.
d. (Optional) Type information in the Sample ID or Comments cells.

The first line should look like Figure 3-30. 

4. (Optional) Review the method. 

a. Click Autosampler Methods to open the Autosampler Method Editor 
dialog.

b. Select the method in the Filename list.
c. Click Cancel to close the dialog without saving changes. 

Figure 3-29 Run Manager Window, Showing Autosampler Method Selection

Figure 3-30 Run Manager Window, Showing One Injection
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5. Create the other injections.

a. Click Seq #1, and then right-click and select Copy. 
b. Highlight the rows 2 through 6 rows, right-click and select Paste.

6. Edit injections 3 to 6 to change the vial and sample information for the second 
sample.

a. Double-click the Vial cell in row 4, then select 02 from the list.
b. Click another cell, then click the Vial cell in row 4 again.
c. Click and drag the small black box down two rows to change the vial from 01 

to 02 (Figure 3-31).

d. Click the Sample Name cell in row 4 and type 10 minutes.
e. Click and drag the Sample Name cell to replace “Control” with “10 minutes”.

The table should look like Figure 3-32. 
The yellow circle around vial 2 in the Current Tray section indicates the vial 
which is selected in the run table. 

7. Add a row for the blank.

a. Copy the last row and paste it into row 7 in the table, 
b. Change the value in the Vial cell to 3.

Note: AB SCIEX recommends that you do not edit autosampler methods.

Figure 3-31 Detail of Run Table, Showing Drag Handle

Figure 3-32 Run Manager Window, Showing Multiple Injections 
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c. Double-click the LC Method cell and select Electrode Flush. 
d. Type Blank in the Sample Name cell.

8. Click File > Save to save the run table.

Start the Run
1. Place the sample vials in positions 1 and 2 of tray 1 of the autosampler. 

2. Place a vial containing the blank (50:50 water:acetonitrile) in position 3.

3. In the run table, select the Run check box column header to queue all injections to 
be run (Figure 3-33).

Clear the check box for any injection you do not want to run.

4. In the Run Sequence section (Figure 3-34) click Start.

After the flow rate has stabilized, sample injection begins. 

After all of the samples have been injected, the system is flushed for 20 minutes.

Monitor the Run

View Run Status in the Run Manager Window

During a run, the color of the row in the run table indicates the status:

• White–the run can be started

• Light green–equilibrating

• Dark green–running

Figure 3-33 Run Manager Window—Run Column Header Check Box

Figure 3-34 Run Manager Window—Run Sequence Section
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• Red–stopped

• Yellow–an error occurred

• Gray–completed

Stop a Run in the Run Manager Window

1. Click  to stop the run. 

2. To start again, either:

• Click  (Reset) to clear the status of every row in the run table, and then 

click  to start the run again at the first row in the run table

or

• Click  to start the run again, beginning at the next row in the run table.

View Run Status in the Acquisition Window

While the run is in progress, the Acquisition window can display the specified flow profiles for 
mobile phases A and B as well as their actual flow rates (Qa and Qb) (Figure 3-35). 

Status bars at the top right of the window display the actual flow rate for pump A (Qa) and pump 
B (Qb) in nL/min, and pressure for pump A (Pa), pump B (Pb) and the column (Pc) (Figure 3-36). 
Right-click the status bars to display a menu where you can customize the status bar display. 

Figure 3-35 Acquisition Window, Showing Flow Profiles
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Status information such as %A, %B, and Time Remaining are also displayed at the bottom of the 
screen during the run.

Use the Control Buttons During a Run

Table 3-4 shows the buttons available in the Acquisition window. 

Zoom in on a Trace

• To zoom in on a particular area of the plot, click and drag a box around the area of 
interest to enlarge that area of the plot. 

To zoom back out, right-click and select Zoom Out or Back.

Figure 3-36 Status Bars for Flow Rate and Pressure

Table 3-4 Acquisition Window Control Buttons

Click... To...
Pause the run.

The system is maintained with its current conditions indefinitely until the run is 
stopped or resumed.

To resume the run, click  (Resume).

Change the run duration.

Select the number of minutes to extend or shorten the run. You can add time 
indefinitely but you cannot shorten the run to less than the original run time in the 
LC method. 

Stop the run.

The run stops and the pumps reset. 

View a dialog containing information about the sample run and other acquisition 
information saved with the data file.

(Not available during a run) Open the Direct Control dialog.

Use this dialog to change the mobile phase composition, flow rate, valve position, 
and column oven temperature when the system is not performing a run.
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Add or Remove Traces from the Acquisition Window

1. In the Acquisition window, click System > Appearance Settings to open the 
Appearance Settings dialog (Figure 3-37).

2. Select the items to view in the plot and, optionally, set the colors for the traces.

3. Click OK to save the changes and close the dialog.

Figure 3-37 Appearance Settings Dialog
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4
Routine Maintenance
This chapter describes procedures to maintain the Eksigent MicroLC 200 Plus system. 

• Basic Maintenance Schedule

• Dispose of Waste

• Inspect the System

• Maintenance Procedures for the Pump

• Maintenance Procedures for the Injection Valve

• Maintenance Procedures for the Turbo V™ Ion Source Electrode

• Maintenance Procedures for the Autosampler

• Configure the Autosampler

• Modify the Calibration Method for an AB SCIEX TripleTOF® System

• Transfer System Settings to a Different Computer

• Store the System

Caution: Potential System Damage: There are no user serviceable components or 
assemblies inside the Eksigent MicroLC 200 Plus pump. Service of any internal parts or 
assemblies should be completed by a trained Field Service Employee (FSE). 

Basic Maintenance Schedule
To ensure reliable performance, the following procedures should be performed at the specified 
interval.
 

Table 4-1 Routine Maintenance for the Eksigent MicroLC 200 Plus System

Maintenance Procedure Frequency
Inspect the System Weekly

Re-initialize the Pressure Transducers Weekly

Verify the DLW Actuator Weekly

Replace the Injection Port Fitting Quarterly

Backflush the Electrode As needed

Calibrate Flowmeters As needed

Dispose of Waste As needed

Modify the Calibration Method for an AB SCIEX 
TripleTOF® System

As needed

Plumb the Injection Valve As needed

Purge Mobile Phases As needed

Replace the Autosampler Fuse As needed
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Routine Maintenance
Dispose of Waste
Properly dispose of the contents of any effluent waste in an appropriate chemical waste 
container. 

Inspect the System
1. Inspect the waste and wash reservoirs for evidence of biological growth or 

precipitation.

2. Lower one of the mobile phase bottles to the table, then loosen the fitting at the rear 
of the pump to check for flow restriction in the DLW frit.

If the liquid flows back into the bottle by gravity the frit is not plugged. You should be 
able to see the liquid/air interface move backwards through the clear tubing.

3. Repeat step 2 with the other mobile phase.

4. Check the injection port fitting and tighten or replace as needed (refer to Replace the 
Injection Port Fitting on page 57).

• The fitting should be dry.

• Check the fit by sliding a spare needle in and out of the fitting. It should be 
snug but able to move. 

5. Check the tightness of the syringe plunger. 

Replace the Injection Valve Pod As needed

Replace the Injection Valve Rotor Seal As needed

Replace the Pump Seal Rinse As needed

Replace the Sample Loop As needed

Replace the Syringe Barrel As needed

Replace the Syringe Needle As needed

Replace the Syringe Plunger As needed

Replace the Wash Solvents As needed

Set the Temperature for the Stack Holder As needed

Sonicate the Electrode As needed

Transfer System Settings to a Different Computer As needed

Test the DLW System As needed

WARNING! Environmental Hazard: Always follow appropriate safety procedures 
and local requirements when handling or disposing of waste chemicals. Refer to 
the Safety Data Sheets for the mobile phases for more information.

Table 4-1 Routine Maintenance for the Eksigent MicroLC 200 Plus System (Continued)

Maintenance Procedure Frequency
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Routine Maintenance
• If the plunger moves easily, replace it (refer to Replace the Syringe Plunger on 
page 74).

6. Visually inspect the system fluidics and electronic connectors.

• Look for evidence of fluid leaks by inspecting all fluid connections.

• Look for dried deposits that may indicate a slow leak.

• As needed, tighten any loose connections.

7. Identify and correct the source of any leaks. 

• If a fluidic connection is broken, replace the fitting and re-flush the system. 

• Inspect the new connection to make sure that no leaks are present.

Maintenance Procedures for the Pump
This section contains the following procedures for the pump:

• Purge Mobile Phases on page 51

• Replace the Pump Seal Rinse on page 52

• Re-initialize the Pressure Transducers on page 52

• Calibrate Flowmeters on page 54

Purge Mobile Phases
After changing the mobile phase bottle(s) or if the system has been idle for a week or more, 
purge the old mobile phase from the system.

1. Make sure the column is not connected.

2. In the Eksigent control software, click System > Mobile Phases, then click More to 
display additional options in the dialog.

3. Purge the mobile phases.

a. In the Purge Settings section, select the Side A or Side B check box as 
appropriate.

b. Specify a minimum of 20 purge cycles.
c. Click Purge Now.

Figure 4-1 Mobile Phase Change Section of the Mobile Phases Dialog—
Settings for High-flow Configuration
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4. Flush the system.

a. In the Flush Settings section, type 500 µL for the Total Volume.
b.  Set the Flush Flowrate based the configuration:

– Type 50 µL/min for the low-flow configuration.
– Type 100 µL/min for the high-flow configuration.

c. Connect one end of a length of 1/32 inch OD tubing to the mobile phase outlet 
on the front of the pump and insert the other end in a waste vial. 

Caution: Potential System Damage: Make sure that no LC columns are 
connected before proceeding with this operation. Flushing the system with a 
column connected could over-pressure the system and create leaks.

d. Click Flush Now. 

5. Click OK to close the Mobile Phases dialog.

6. Reconnect the column.

Replace the Pump Seal Rinse
As needed, discard the pump seal rinse (in the small bottle on top of the pump) and replace with 
new solvents. Use a 50:50 mixture of water and a common alcohol such as methanol, ethanol, or 
propanol and fill the bottle 2/3 full.

Re-initialize the Pressure Transducers

1. Stop the system flow.

2. Loosen the outlet fitting of the pump to release all of the residual pressure.

3. Click System > Hardware Diagnostics.

4. On the Flow Calibration tab, select the Re-Initialize Transducers check box.

Note: Before re-initializing the pressure transducers, open the pump outlet to ensure 
that there is no residual pressure on the outlet of the pump. Attempting to re-initialize the 
pressure transducers while there is still residual pressure on the pump will lead to 
inaccurate flow rates.
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5. Click Start Diagnostics. 

A warning appears that this procedure should only be performed if there is no 
residual pressure on the pump.

6. Make sure that the pump outlet is open, and then click OK.

A status dialog indicates that re-initialization is in progress.

7. When the system displays that it is at ambient pressure, click OK.

8. When re-initialization is finished, exit the Hardware Diagnostics dialog and return to 
the Acquisition window.

Figure 4-2 Hardware Diagnostics Dialog—Flow Calibration Tab
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Calibrate Flowmeters
Calibrating flowmeters consists of measuring the velocity of a liquid front in a tube of known 
diameter. Measure the flow rate to determine if the flowmeters need calibration.

Different configurations of the Eksigent MicroLC 200 Plus system have different flow rates and 
require different pipettes for calibration (Table 4-2).

Measure the Flow Rate

1. Connect the flow calibration assembly to the pump using the autotuning assembly. 

a. Disconnect the tubing from the pump outlet.
b. Connect the autotuning assembly to the pump.
c. Insert the free end of the autotuning assembly into the silicone tubing on the 

calibration pipette (Figure 4-3).
Refer to Table 4-2 to select the correct pipette for the system configuration.

2. Using the Direct Control dialog, measure the time to fill the pipette with the volume 
specified in Table 4-2.

For either configuration, the expected time is 240 seconds. A range of 230 to 250 
seconds is acceptable.

3. Do one of the following:

Note: Make sure the system has been purged, flushed, and the pressure transducers 
re-initialized before proceeding with flowmeter calibration. Failure to do so will result in 
poor performance of the system.

Required Materials
• Calibration kit (with 100 µL and 200 µL pipettes) (PN 5018262)

• Autotuning assembly (PN 5018474)

• External timer

Table 4-2 Calibration Pipette Specifications

High-flow Configuration 
(20-200 µL/min)

Low-flow Configuration 
(5-50 µL/min)

Calibrated pipette volume 200 µL 100 µL

Calibration flow rate 100 µL/min 25 µL/min

Figure 4-3 Calibration Pipettes—100 µL (Top) and 200 µL (Bottom)
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• If the flow is within an acceptable range, the flowmeters do not need 
calibration.Disconnect the autotuning assembly and reconnect the original 
tubing between the pump and the injection valve.

• If the flow is not in the acceptable range, proceed to Calibrate the Flowmeters.

Calibrate the Flowmeters

1. If needed, connect the flow calibration assembly to the pump (refer to step 1 on 
page 54).

2. Click System > Hardware Diagnostics.

3. Click Calibrate Flowmeter Ch 1 to open the Flowmeter Calibration wizard.

4. In Step 1, verify that the Mobile Phases are correct and click Next (Figure 4-4).

If the mobile phases are not correct, click Cancel and make the necessary changes 
in the Mobile Phases dialog. Repeat these steps.

5. In the Flowmeter Calibration wizard, set the pipette size (Figure 4-5).

• For the high-flow configuration—select 200 µL/division.

• For the low-flow configuration—select 100 µL/division.

6. Click Next to start the flow in channel A. 

7. In Step 3, specify the appropriate Volume (Figure 4-6). 

• For the high-flow configuration—type 200.

• For the low-flow configuration—type 100.

Figure 4-4 Flowmeter Calibration Wizard—Step 1

Figure 4-5 Set the Flowmeter Calibration Pipette Size—High-flow 
Configuration
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8. Bring the liquid front to the black line on the pipette and then click Start to begin the 
timer. 

9. When the fluid front reaches the end of the pipette, click Stop. 

10. Click Next. 

11. Repeat this procedure to calibrate the channel B flowmeter.

12. Click Finish.

13. Do one of the following:

• If the calibration passed, repeat the Measure the Flow Rate procedure to 
determine if the flow rate is within acceptable bounds.

• If the calibration failed, check for leaks, verify the settings in the Mobile 
Phases dialog are correct for the solvents in use, and purge and flush the 
system, then repeat the calibration. If the calibration fails again, contact AB 
SCIEX Technical Support.

14. Disconnect the autotuning assembly and reconnect the original tubing between the 
pump and the injection valve.

Check Flow Stability
The Check Flow option in the Hardware Diagnostics dialog should not be used. The test was 
developed for earlier versions of the Eksigent MicroLC 200 Plus system and the results are no 
longer meaningful.

Maintenance Procedures for the Injection Valve
This section contains the following procedures for the injection valve:

• Replace the Injection Port Fitting on page 57

• Replace the Sample Loop on page 57

• Replace the Injection Valve Rotor Seal on page 58

• Replace the Injection Valve Pod on page 59

Figure 4-6 Set the Flowmeter Calibration Volume

Figure 4-7 Example of Flow Direction—High-flow Pipette
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• Plumb the Injection Valve on page 61

• Install the Electrode and Grounding Assembly for the Ion Source on page 64

• ESI Electrode Assemblies on page 65

Replace the Injection Port Fitting

1. Remove the fitting in port 3.

2. Replace the fitting (Figure 4-8) and tighten until finger-tight.

3. Insert the spare needle into the fitting port 3 and slide it in and out. 

4. Tighten the fitting until the needle is snug but can still move in and out of the fitting.

5. Follow the steps in Configure the Needle Penetration Depth on page 80 to check 
and, if necessary, set the needle penetration depth.

Replace the Sample Loop
The sample loop (2 µL) is pre-installed and is located between ports 1 and 4 on the HTC-xt PAL 
autosampler valve (Figure 4-11 on page 61). If you suspect a clog, you can change the sample 
loop.

1. Remove the loop.

2. Connect the new loop to port 1 on the injection valve of the autosampler using the 
tightening tool and one of the nuts and ferrules.

3. Connect the other end of the loop to port 4 with the other nut and ferrule.

Required Materials
• Injection port fitting (PN 5023797)

• Spare needle (PN 5031383)

Figure 4-8 Injection Port Fitting

Required Materials
• Sample loop (PN 5017800)

• Tightening tool (PN 200-00356)

• 2 nuts (PN 5024174)

• 2 ferrules (PN 910-00087) 
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Replace the Injection Valve Rotor Seal

Replace the valve rotor seal if the valve leaks or doesn’t hold pressure.

1. (Optional) Remove the sample loop and any tubing connected to the injection valve:

2. Remove the valve stator and rotor seal.

a. Use a 9/64 inch Allen key to remove the three Allen screws from the top of the 
valve stator.

b. Lift off the stator and set it aside.
c. (Optional) Lift off the black plastic alignment cylinder and set it aside.
d. Remove the rotor seal.

The rotor seal consists of a black disk in a silver case.

Required Materials
• 9/64 inch Allen key

• Injection valve rotor seal (PN 200-00326)

Note: It may be possible to lift out the rotor seal without removing the 
alignment cylinder. 

Figure 4-9 Injection Valve—Top View, with Stator Removed

Item Description
1 Rotor seal

2 Alignment cylinder

1

2
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3. Install the new rotor seal.

a. Place the new rotor seal on the valve, seating it on the three pins.
b. Replace the black plastic alignment cylinder on the valve, rotating as needed 

to seat it.
c. Replace the stator and tighten the Allen screws.
d. If needed, re-plumb the injection valve.

Refer to Plumb the Injection Valve on page 61 for detailed instructions.

Replace the Injection Valve Pod

1. Remove the sample loop and any tubing connected to the injection valve,

2. Remove the pod from the acutator.

a. Unscrew the black ribbed retaining nut that holds the pod in the actuator. 
Do not use a wrench. The retaining nut should only be tightened and loosened 
by hand.

b. Pull the pod from the actuator.

3. Replace the pod.

a. Insert the new pod into the actuator. 
The pod union will make contact with the spline in the actuator.

b. Press lightly and rotate the pod until the pod slips further into the actuator and 
the pin contacts the actuator.

c. Continue to rotate the pod until the pin is seated in the notch in the actuator, 
then push it in (Figure 4-10).

d. Replace the retaining nut and tighten by hand.

Required Materials
• Tightening tool (PN 200-00356)

• Tightening tool (PN 200-00404)

• Injection valve pod (PN 200-00452)

Note: The position of the pod does not matter when installing. 
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4. Re-plumb the injection valve.

Refer to Plumb the Injection Valve on page 61 for detailed instructions.

Figure 4-10 Valve Pod—Side View, Showing Pin in Notch
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Plumb the Injection Valve

Figure 4-11 Injection Valve Plumbing with Grounding Assembly (Left) and Fittings and 
Tools (Right)

Item Description Part Number
1 Injection port 5023797

2 Injection valve waste tube assembly 5017800

3 Gold-colored fittings (and ferrules) for all ports on injection 
valve except number 3

• Nuts

• Ferrules

5024174

910-00087

13

7

7

8

10

2

4 1

7

12

3

5

9

14

6

3

12

1

11

9
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Best Practices for Working with PEEKsil Tubing

• Never cut PEEKsil tubing.

Cutting PEEKsil tubing can result in small particles of cut glass entering the flow 
path, leading to plugged tubing and electrodes.

• When connecting PEEKsil tubing:

a. Connect the tubing on the end farther from the mass spectrometer first.

4 One of the following:

• 2 µL PEEKsil loop

• 5 µL PEEKsil loop

• 10 µL PEEKsil loop

5017798

5017799

205-00054

5 Mixer-to-valve assembly 5017801

6 Gray PEEKsil tubing, 50 µm ID, 1/32 inch OD, 30 cm 

(If needed to accommodate laboratory layout, use 50 cm.)

205-00040 (30 cm)

205-00041 (50 cm)

7 Black PEEK fitting 

(If necessary, use tool PN 200-00356.)

200-00342

8 2.7 µm HALO fused C18 column, 0.5 mm x 50 mm 805-10100

9 Gray PEEKsil tubing, 50 µm ID, 1/32 inch OD, 5 cm

or

Orange PEEKsil tubing, 25 µm ID, 1/32 inch OD, 5 cm 
(Use for flows < ~20 µL/min)

(For systems without the in-line filter, use 10 cm of tubing 
between the column and the electrode.)

205-00070

205-00089

10 Grounding assembly 5016941

11 In-line filter 200-00388

12 Red PEEK nonconducting fitting (use for <5000 psi only) 
(see note below)

200-00330 

13 One of the following (see note below):

• 65 µm ID electrode 

• (Available separately) 50 µm ID electrode

• (Available separately) 25 µm ID electrode (Use for flows 
<~20 µL/min.)

5029342

5028466

5028467

14 Tool for PEEK fittings (PN  200-00342) 200-00356

Note: When connecting the 65 µm ID electrode, use a red PEEK fitting (item 12) 
immediately before the electrode. For the 25 µm ID and 50 µm ID electrodes, use either 
the red fitting or a black PEEK fitting (item 7).

Item Description Part Number
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b. Turn on the pump and allow liquid to flow through the tubing to flush out any 
particulate matter.

c. Allow flow for ~30 seconds before making the next connection.

• Don’t overtighten connections to PEEKsil tubing. 

Overtightening can damage tubing and lead to plugged tubing. Instead, tighten 
fittings until finger-tight, turn on the pump and check for solvent at the fitting. If there 
is a leak, tighten the fitting about 1/16 turn at a time until there are no more leaks.

Step-by-Step Instructions for Plumbing the Injection Valve

1. Loosely install the fittings in the ports.

• For port 3, use item 1 in Figure 4-11.

• For all other ports, use nuts and ferrules (item 3).

2. Connect the waste tube assembly (item 2).

a. Attach the tubing to port 2. 
b. Bend the metal around the valve spill collar so that it holds the clear tubing 

below the valve and will not get caught by movement of the autosampler. 
c. Connect the other end of the tubing to the upper port on the front of the wash 

station (Figure 4-11 on page 61).

3. Install the mixer-to-valve assembly (item 5) in port 6. 

Leave the other end of the assembly free, for installation to the pump outlet later.

4. Install the sample loop (item 4) into ports 1 and 4, using a 3/16 inch wrench.

5. Connect the column.

a. Install 30 cm of 50 µm ID tubing, 1/32 inch OD PEEKsil tubing (item 6) in port 
5. 

b. Connect the other end of the tubing to the column inlet using a black PEEK 
fitting (item 7).

6. Connect the column outlet to the in-line filter (item 11) and the in-line filter to the 
electrode.

a. For each connection, use 5 cm of 1/32 inch OD PEEKsil tubing (item 9).

• Flow rates > ~20 µL/min—50 µm ID tubing (PN 205-00070)

• Flow rates < ~20 µL/min—25 µm ID tubing (PN 205-00089) 

b. Connect the other end of the tubing to the electrode, using the appropriate 
fitting:

• 25 µm and 50 µm ID electrodes—black PEEK fitting (PN 200-00342) 
(item 7).

• 65 µm ID electrodes—red PEEK fitting (PN 200-00330) (item 12).

Tip! If necessary to accommodate the laboratory layout, longer tubing can 
be used, but make the length of the tubing from the valve to the column as 
short as possible.
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7. Place the column in the column oven.

8. Cut a piece of the foam block (PN  5023403, from the column oven kit) and place it in 
the column heater on top of the column.

Install the Electrode and Grounding Assembly for the Ion 
Source

Based on the planned flow rates for the system, install the appropriate electrode assembly in the 
Turbo V™ ion source probe.

1. Replace the existing spring with the one provided with the electrode.

2. Insert the electrode into the central shaft of Turbo V probe in the same manner as 
the standard larger ID Turbo V electrode. 

3. Tighten the black screw cap on the probe and adjust as needed to extend the 
electrode tip 1 mm to 2 mm past the probe tip. 

4. Clip one end of the black grounding cable (PN 5016941) to the grounding point on 
the ion source. 

5. Clip the other end to the appropriate location for the electrode.

• 25 µm and 50 µm ID electrodes—clip to the grounding union on the probe

• 65 µm ID electrode—clip to the column in the column oven

6. Close the column oven.

WARNING! Electrical Shock Hazard: For the 65 µm ID electrode, use 
the red fitting to prevent the risk of an electrical shock. Do not use 
conductive fittings such as the high-pressure carbon-filled black 
fittings.

WARNING! Electrical Shock Hazard: Do not bypass the grounding union 
connection. The grounding union provides grounding between the mass 
spectrometer and the sample introduction device.

Table 4-3 Suggested Electrode, Based on Flow Rate

Flow Rate (µL/min) Electrode
5 to 20 25 µm ID (PN 5028467)

20 to 50 50 µm ID (PN 5028466)

20 to 100 65 µm ID (PN 5029342)

Note: The upper limit for flow rate is ultimately determined by the pressure limits of the 
system and the column.
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ESI Electrode Assemblies
Figure 4-12 shows the plumbing and connections for ESI electrode assemblies.

Figure 4-12 ESI Probe Plumbing—25 µm ID Electrode (Left) and 50 µm and 65 µm ID 
Electrodes (Right)
Operator Guide Eksigent MicroLC 200 Plus System

RUO-IDV-05-1129-B | D5033433 G  65 of 140



Routine Maintenance
Maintenance Procedures for the Turbo V™ Ion 
Source Electrode
This section contains the following procedures:

• Backflush the Electrode on page 66

• Sonicate the Electrode on page 69

Backflush the Electrode
If the electrode is plugged, backflush the electrode using the Eksigent MicroLC 200 Plus pump. 

1. Remove the column from the flow path and connect the tubing with a union.

a. Loosen the black PEEK fitting from the upstream end of the column. 
b. Remove the 1/32 in OD PEEKsil tubing from the column and connect it to the 

stainless steel hex union (item 3 in Figure 4-13) using the fitting.

c. Insert the sleeve (item 4) into a black PEEK fitting. Insert the sleeve with the 
flared end of the sleeve at the rear of the fitting.

d. Insert the probe tip (item 5) into the sleeve using the flare as a guide.

Required Materials
• Stainless steel hex union (PN 5016413)

• Flared sleeve (PN 5025189)

• 2 PEEK fittings (PN 200-00342)

Figure 4-13 Components for Connecting the System to Backflush the 
Electrode

Item Description
1 1/32 in OD PEEKSil tubing

2 PEEK fittings

3 Stainless steel hex union

4 Flared sleeve

5 Electrode assembly 

1 2 23 4 5
Eksigent MicroLC 200 Plus System Operator Guide

66 of 140 RUO-IDV-05-1129-B | D5033433 G



Routine Maintenance
The first time the sleeve is used, make sure that the sleeve is pushed as far as 
possible into the union. After the first use, the sleeve will remain in the fitting.

e. Tighten the fitting into the union so that the probe tip is snug. 

2. Start the pumps.

a. Select System > Direct Control in the Eksigent control software to open the 
Direct Control dialog.

 

b. Select Monitor Baseline to monitor pressure while backflushing. 
c. Specify the flowrate to be 5 µL/mL.
d. Specify A and B so the solvent pumped is mostly organic.
e. Click Start.

Caution: Potential System Damage: Do not allow the pressure to exceed 
10 000 psi. Stop the pump if the pressure is greater than 10 000 psi.

3. Monitor the baseline in the Acquisition window.

If necessary, configure the window so that Pc appears in the plot.

a. Select System > Appearance Settings.
b. In the Appearance Settings dialog, select the Column (Pc, psi) check box in 

the Pressure section.
c. Click OK.

Figure 4-14 Direct Control Dialog
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4. Increase the flowrate, up to the maximum for the instrument’s configuration (below) 
and pump until either the probe backpressure is reduced and stable or for 20 
minutes, which ever comes first. 

• High-flow configuration—200 µL/min

• Low-flow configuration—50 µL/min

The pump can be left unattended and be allowed to restroke repeatedly to dislodge 
the plug. The pressure fluctuations due to restroking or changing flow rate will aid in 
dislodging the blockage. If necessary the probe can be inserted into an ultrasonic 
bath while backflushing.

Figure 4-15 Appearance Settings Dialog—Pressure Section

Tip! Each time the pump restrokes, the Eksigent control software displays 
the error log. Minimize the window to hide it.

Figure 4-16 Acquisition Window, Showing Pressure Drop
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5. Click Stop.

If the pressure dropped, the plug has been dislodged. Remove the union and 
reconnect the column into the flow path.

If the pressure is still high, follow the procedure below to sonicate the electrode.

Sonicate the Electrode
Sonicate the electrode only if backflushing did not remove the plug.

1. Remove the electrode from the system.

2. Place the tip of the electrode in the beaker then add enough solvent to cover the tip 
and then a bit more. Sonicate for 10 minutes.

3. Replace the electrode in the source and flush the electrode a second time.

Maintenance Procedures for the Autosampler
This section contains the following procedures for the autosampler and the DLW:

• Replace the Wash Solvents on page 69

• Set the Temperature for the Stack Holder on page 70

• Replace the Autosampler Fuse on page 70

• Test the DLW System on page 71

• Verify the DLW Actuator on page 72

• Replace the Syringe Barrel on page 73

• Replace the Syringe Plunger on page 74

• Replace the Syringe Needle on page 75

Replace the Wash Solvents
As needed, replenish the wash solvents in the 1 L glass bottles on top of the pump, using:

• Water with 0.1% formic acid

• Acetonitrile (or other organic solvent) with 0.1% formic acid

Required Materials
• Sonicator

• Beaker

• Acetone, methanol, ethanol, or warm water
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Set the Temperature for the Stack Holder
The temperature setting for the stack holder is shown on the front of the stack holder power 
supply. Change the temperature if the default is not applicable.

1. Press P for less than two seconds.

“SP1” is displayed.

2. Press the Up and Down arrows to reach the desired temperature.

3. Press P again to set the temperature.

Replace the Autosampler Fuse

1. If the system is not already off, turn off the power switch on the autosampler power 
supply.

2. Remove the fuse from the back of the Z arm of the autosampler (Figure 4-18).

3. Replace the fuse.

4. Power up the system.

Figure 4-17 Stack Holder Power Supply Control Panel

Required Materials
• 6.3 A 250 VAC 5 mm x 20 mm fuse

Figure 4-18 HTC-xt PAL Autosampler Z-Arm—Rear View

Item Description
1 Fuse

1
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Test the DLW System

1. Verify the wash solvent is delivered at the dynamic load and wash (DLW) pump 
outlet.

a. Disconnect one of the two outlet tubings from the Z-arm (Figure 4-19) and 
place it into the beaker.

b. Using the keypad terminal, select Menu > Utilities > Wash Station > 1 (or 2) 
> MovtoWash (F3) > ActValve (F2) to start the pump.

c. Wait 30 seconds and measure the volume of the collected liquid using the 
graduated cylinder.
The cylinder should contain approximately 10 mL.

Required Materials
• Short beaker or other container to catch wash solvent during the test

• 10 mL or 20 mL graduated cylinder

Note: This test procedure requires the use of water as the wash solvent. Organic 
solvents typically have lower viscosities and higher flow rates, resulting in final volumes 
that are different than those below.

Figure 4-19 Outlet Tubing to Z-arm Connection
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If there is <10 mL in the cylinder, the pumps are not working or the solvent 
lines are restricted. 
If there is >10 mL in the cylinder, go to step 2.

2. Verify the wash solvent is delivered at the needle.

a. Reconnect the outlet tubing to the Z-arm.
b. Disconnect the corrugated tubing from the barbed fitting on the bottom of the 

wash station.
c. Place the beaker under the barbed fitting to catch the outflow.
d. Using the keypad terminal, select Menu > Utilities > Wash Station > 1 (or 2) 

> MovtoWash (F3) > ActValve (F2) to start the pump.
e. Wait 30 seconds, then press Deact Valve (F3) > Esc to stop the pump.
f. Measure the volume of the collected fluid.

The cylinder should contain approximately 8 mL.
If there is >8 mL in the graduated cylinder, the DLW system is working 
correctly.
If there is less than ~8 mL, the flow is restricted somewhere in the flow path. 
Check the following:

• Verify there is no crimped or pinched tubing in the flow path and make sure 
that flow reaches the tan PEEK fitting at the DLW actuator. 

• Verify the connections to the sample loop are not leaking.

• Verify the white Teflon needle seal is correctly inserted and the needle is 
installed correctly. If the needle has been previously bent and then 
straightened, install a new needle. 

Repeat step d through step f.

3. Repeat step 1 and step 2 for the tubing for the other outlet.

Verify the DLW Actuator
The DLW actuator is the valve associated with the DLW option for the HTC-xt PAL autosampler. 
It is located in the syringe holder assembly on the Z-arm.

1. Make sure the syringe needle is over the waste or in a wash position.

2. On the keypad terminal, select Menu (F1).

3. Turn the outside circular button clockwise to position the cursor over Utilities and 
press Enter.

This displays the service menu.

4. Select Wash Station > Wash 1.

5. Press F2 to turn on wash pump 1 and open the valve.

6. Press Enter.

Verify the blue LED on the syringe holder is lit.

If liquid does not flow out of the syringe, check the fluidic and electronic connections. 
The blue LED to the right of the syringe indicates that power is supplied to the 
actuator.
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Replace the Syringe Barrel

1. On the keypad terminal, select Menu > F1 Chang Syr. 

The injection unit moves to a location convenient for accessing the syringe and 
needle.

2. Remove the syringe barrel.

a. Unscrew the knurled nuts at the top and bottom of the syringe 
b. Lift the syringe up and out to remove it.

3. Prepare the new syringe barrel (Figure 4-20).

a. Manually move the plunger to the stop position.
b. Pull the plunger backward slightly backwards to release a slight amount of 

pressure from the plunger tip.
c. Install the plunger holder and tighten the Allen screw firmly.

4. Replace the syringe barrel (Figure 4-21).

a. Screw the prepared syringe barrel into the holder. 
Hold the syringe barrel at the lower metal mount while tightening the syringe. 

b. Move the plunger up (plunger holder) until the thread of the screw catches the 
thread of the plunger bushing. 

c. Tighten the screw to fix the plunger holder.
d. Tighten the holding screw to secure the syringe holder position. 

Note: It is critical that syringes be primed before beginning sample preparation. Prime 
every syringe manually before inserting it into the autosampler. After insertion, flush the 
syringe. 

Required Materials
• Syringe barrel (PN 4460861)

• T6 Torx driver

Figure 4-20 Inserting the Plunger Holder in the Syringe Barrel
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. 

5. Insert the syringe needle tip into the lower needle guide, then move the needle back 
up to the needle holder and tighten firmly. 

6. Press F4 Home.

The plunger moves down until it hits the mechanical stop. This position is stored as 
the syringe’s zero volume position. The injection unit then returns to the home 
position.

7. Select Menu > Utilities > Syringe > F2 Clean Syr to flush the syringe.

Replace the Syringe Plunger

1. On the keypad terminal, select Menu > F1 Chang Syr. 

The injection unit moves to a location convenient for accessing the syringe and 
needle.

2. Remove plunger holder and syringe barrel.

3. Pull out the plunger.

4. Flush barrel with alcohol to remove debris and act as a lubricant for the plunger.

5. Carefully insert the new plunger into the syringe barrel.

6. Replace the plunger holder and syringe barrel.

Figure 4-21 Connecting the Syringe Plunger Holder 

Required Materials
• Syringe plunger (PN 4460827)
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Replace the Syringe Needle
After the needle is replaced, the needle penetration depth on the autosampler must be reset.

1. Select Menu > F1 Chang Syr. 

The injection unit moves to a location convenient for accessing the syringe and 
needle.

2. Loosen the knurled needle retaining nut and remove the needle.

3. Prepare the new needle.

a. Insert the needle into the Teflon seal.
Sometimes the hole in the seal contains a burr, Teflon residue from the seal 
(Figure 4-22).

b. If necessary, remove any burrs created by the insertion. 
Remove the seal from the needle and use the long end of the needle to push 
the burr out.
Be careful not to scratch the seal.

Required Materials
• Needle and Teflon seal (PN 5031383)

Figure 4-22 Teflon Needle Seal—Clean Seal (Left) and Seal with Burr (Right)
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4. Install the needle.

a. With one hand, lift up the bottom needle guide until it touches the upper 
needle guide. 

b. With the other hand, guide the tip of the new needle into both guides and then 
release the bottom needle guide.

c. Insert the top of the needle into the fitting and tighten the needle collar until 
finger tight (Figure 4-24).

5. Gently slide the lower needle guide up and down to make sure the tip of the needle 
is near the bottom of the hole in the needle guide.

Figure 4-23 Syringe Needles and Seals, Showing Cleaning the Needle Seal 
(Right)

Figure 4-24 Syringe Needle Collar

Item Description
1 Needle collar

1
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If the needle tip is above the hole at rest, the needle will probably hit the hole when 
compressed, bending the needle.

6. Follow the steps in Configure the Needle Penetration Depth on page 80.

Configure the Autosampler
If any of the components attached to the autosampler are moved, use the keypad terminal to 
adjust the X, Y, and Z positions of the injection unit. This section contains the following 
procedures:

• Configure the Tray Holder Position on page 77

• Configure the Wash Station Position on page 78

• Configure the Injector Waste Position on page 79

• Configure the Injection Port Position on page 79

• Configure the Needle Penetration Depth on page 80

• Configure the Autosampler Tray Type on page 81

• Adjust the Needle Penetration into the Sample Vial on page 81

Configure the Tray Holder Position
1. Open the top drawer in the stack holder. 

Make sure that the drawer is empty. The tray calibration hole should be visible.

2. On the keypad terminal:

a. Press Menu (F1).
b. Turn the outside circular button clockwise to position the cursor over Setup.
c. Press F3 and then press Enter (inside circular button) in quick succession.

This displays the service menu.
d. Using the outside circular buttons to scroll, select Objects > Tray Holders > 

CStack1. Press Enter after each selection.

3. Select Clear Position (F2) and then select Z. 

4. Select Check Position (F1) to move to the preset X and Y positions.

5. If needed, adjust the X, Y, and Z positions until the needle guide is accurately placed 
in the tray calibration hole. 

Make sure the bottom of the needle guide is flush with the bottom surface of the tray.

6. Select Check Position (F1) to verify the needle guide position.

7. Press ESC twice to return to the Objects menu.

8. Close the drawer.
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Configure the Wash Station Position
1. On the keypad terminal, navigate to Menu > Setup. 

2. Press F3 then press Enter.

3. Select Objects> Wash Stations and then press Enter.

4. Select Wash1 and press Enter.

5. Select Clear Position (F2) and then select Z. 

6. Select Check Position (F1) to move to the preset position.

7. Adjust the X, Y, and Z positions until the needle guide is in the Wash1 port (Figure 4-
25).

8. Press Enter.

9. Select Check Position (F1) to verify the position.

10. Press Esc.

11. Repeat step 1 through step 10 for Wash2.

Figure 4-25 Wash Station—Top Ports

Item Description
1 Wash1 port

2 Waste port

3 Wash2 port

2
1

3
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Configure the Injector Waste Position
1. On the keypad terminal, navigate to Menu > Setup.

2. Press F3 then press Enter.

3. Select Objects> Injectors and then press Enter.

4. Select Waste and press Enter.

5. Select Clear Position (F2) and then select Z. 

6. Select Check Position (F1) to move to the preset position.

7. Adjust the X, Y, and Z positions until the needle guide is seated in the Waste port 
(Figure 4-25). 

8. Press Enter.

9. Select Check Position (F1) to verify the position.

10. Press Esc twice.

Configure the Injection Port Position
If the injection valve has been moved or the needle does not go to the correct location, 
reconfigure the injection port position. After you have reconfigured the port position, the needle 
penetration depth should be verified and reconfigured as needed.

The seal for the injection port needs to be tight to avoid leaks. Tighten the injection port as 
described below, then check the seal by doing a trial run. If solvent is appears at the port, tighten 
the fitting about 1/16 of a turn at a time until there are no more leaks.

1. Seat the injection port fitting.

a. Using a spare syringe needle, manually insert the needle into the injection 
fitting in valve position 3.

b. Tighten the fitting by hand until the needle is very snug.

2. On the keypad terminal, navigate to Menu >Setup.

3. Press F3 then press Enter.

4. Select Objects > Injector and then press Enter.

5. Select LC Vlv1 and press Enter.

6. Select Clear Position (F2) and then select Z. 

Be sure to clear the Z position. If the Z position is not cleared, the needle may be 
damaged when you check the position. 

7. Adjust the X, Y, and Z positions until the needle guide is centered over the injection 
fitting. 

8. Press Enter.

9. Select Check Position (F1) to verify the position.

Tip! Tighten the fitting until the needle can’t be removed, then loosen the 
fitting a small amount. The fitting is tight enough when the fitting doesn’t 
leak when injecting.
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10. Configure the Needle Penetration Depth.

11. Press Esc five times to return to the main menu.

Configure the Needle Penetration Depth
1. Check the needle penetration depth.

a. On the keypad terminal, navigate to Menu > Setup.
b. Press F3 then press Enter.
c. Select Objects > Injectors and then press Enter.
d. Select LC Vlv1.
e. Select Needle Penetr and press Enter.

The needle penetration depth is correct if the plate contacts the syringe holder 
assembly and the spring plate is fully compressed (Figure 4-26). 

If the penetration depth is not correct, continue to the steps below to set and verify 
the depth.

2. Set the needle penetration depth.

a. Select Clear Position (F2) and then select Z. 
b. Select Check Position (F1) to move to the preset position.
c. Slowly rotate the outer knob to adjust the needle penetration depth. 

The needle moves stepwise down into the injection port.
d. When the needle tip enters the valve needle guide, slow down the Z 

movement. 
Move down stepwise until the moving plate contacts the syringe holder 
assembly and the spring plate is fully compressed (Figure 4-26). 
Always observe the needle during this step.

Figure 4-26 Needle Penetration Depth, Correct Compression Shown on Far 
Right

Note: This is more force than CTC recommends for conventional injection 
ports.
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e. Rotate the outer knob two steps in the opposite direction and press Enter to 
save the value for needle penetration depth.

f. Press F3 Movto Zero.

3. Repeat step 1 to verify the needle penetration depth.

If the needle bends, or the liquid appears at the fitting when doing a wash, repeat 
step 2.

Configure the Autosampler Tray Type
The default tray type is VT54. If the you want to use a different tray type, use this procedure to 
change the tray type.

1. Using the keypad terminal, select Menu > Utilities > Tray > 1 > Tray Station.

2. Scroll to the tray of interest and press Select to set the tray type.

3. Press Esc.

4. Repeat for tray positions 2 through 6.

Adjust the Needle Penetration into the Sample Vial
If the vial septa or vial cap changes from when the autosampler was first configured, or if vial 
inserts are being used, the depth at which the needle penetrates the vial may need to be 
changed.

1. Place a vial in position 001 in Tray 1 in the stack cooler.

2. Close the drawer of the stack cooler.

3. Set the needle penetration depth.

a. Using the keypad terminal, select Menu > Utilities > Tray > 1 > F3 to move to 
vial 001.

b. Select OK > Needle Pentr.
The needle is inserted into the vial to the currently set depth.

c. Hold the lower needle guide up and then pick up the vial or tray to see how far 
the needle is from the bottom.

d. Scroll to set the needle depth and press Select to set the value.
If you can’t scroll to the required depth (the needle stops before the required 
needle penetration is reached) follow the instructions in step 4 to increase the 
allowed range for needle penetration. 

4. If needed, increase the needle penetration range.

a. Using the keypad terminal, select Menu > Setup. 

Note: Changing this needle penetration will change the penetration for all trays of the 
selected type.

Tip! Use a vial with a missing or torn septa so that it is easier to slide the 
vial up and down when you check the depth.
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b. Press F3 and then press Enter.
c. Select Setup > Objects >Tray Types > VT54 (or the tray in use) > Max 

Needle Penetrat > Select.
d. Scroll to adjust the value and press Select to set the value.
e. Repeat step 3 to set the depth.

Modify the Calibration Method for an AB SCIEX 

TripleTOF® System
For an AB SCIEX TripleTOF 4600 or 5600 system with CDS, the calibration method template 
must be modified so that the Eksigent MicroLC 200 Plus pump will continue to flow during the 
calibration run on the mass spectrometer. Without this modification, the signal stability on the 
mass spectrometer will be poor. This modification is initially performed by the AB SCIEX FSE 
during the installation of the Eksigent MicroLC 200 Plus system. 

The calibration method template may need to be modified if:

• The Analyst software has been reinstalled or a different computer is connected to the 
system

• The column or other system plumbing will not support a 40 µL/min flow rate.

• The initial mobile phase composition for the run is very different from Table 3-1.

• The flow rate of the CDS is >500 µL/min.

Follow these steps to modify the calibration template:

1. Create the LC Method for the Calibration Method Template.

2. Update the Calibration Method Template.
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Create the LC Method for the Calibration Method Template
This method will run during the calibration run.

Caution: Potential System Damage: The LC method below is valid for the sample 
experiment described in Chapter 3. For other experimental conditions, the 40 µL/min flow 
rate may be too high for the column. In that case, edit the LC method and set the flow rate 
and the mobile phase composition as appropriate.

1. Click LC Methods.

2. In the Name box, type a name for the method, and then click Save. 

3. On the Run Conditions tab, set the parameters as shown in Figure 4-27.

Figure 4-27 LC Method Settings Dialog—Run Conditions Tab
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4. On the Gradient Profile tab, set the profile shown in Figure 4-28.

As needed to support different experimental conditions or a different instrument 
configuration:

a. Type the initial value for mobile phase B (for the beginning of the run) in the % 
field.

b. Type the appropriate value for the current column and plumbing configuration 
in the Total flowrate field.

c. If the flow rate for the CDS is greater than 500 µL/min, calculate the duration 
for the LC method: 1000/CDS flow rate. 

d. Type the new duration in the t = min field. 

5. Click Save.

6. Click OK.

Update the Calibration Method Template
Add the LC device and the LC method to the calibration method template.

1. Back up the AutoCalPos.dam file in a safe location.

By default, the file is found in D:\Analyst Data\Projects\API Instrument\Instrument 
Optimization\methods.

2. Add the LC device to the AutoCalPos method.

a. In the Analyst software, activate the hardware profile that includes the 
Eksigent MicroLC 200 Plus system.

b. In Windows, navigate to the location of the AutoCalPos.dam file.

Figure 4-28 LC Method Settings Dialog—Gradient Profile Tab
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By default, this is D:\Analyst Data\Projects\API Instrument\Instrument 
Optimization\methods.

c. Double-click the file AutoCalPos.dam to open it in the Acquisition Method 
Editor in the Analyst software.

d. Right-click Acquisition Method and select Add/remove device.
e. In the Add/Remove device methods dialog, select Eksigent 1 and then click 

OK.

3. Select the LC method.

a. In the Acquisition Method Browser pane, click Eksigent 1.
b. Click ... (Browse) to view the available LC methods.
c. Click the name of the method created previously and then click Open.

4. Save the calibration method with the same name (AutoCalPos) in the original 
location.

Figure 4-29 Add/Remove device methods Dialog
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Transfer System Settings to a Different Computer
To use the Eksigent MicroLC 200 Plus system with a different computer, you must install the 
Eksigent control software on the new computer, transfer important files from the existing 
computer, and then configure the software on the new computer.

1. Copy the autosampler method from the current computer to the thumb drive.

a. Navigate to the D:\Analyst Data\Projects\API Instrument\LC Devices\CTC PAL 
folder.

b. Copy the latest version of the .cyx file (currently “microLC200-Injection-Rev 
B”) to the thumb drive.

2. Copy the Settings folder to the thumb drive.

a. Navigate to the installation directory, either C:\Program 
Files\EksigentNanoLC on 32-bit operating systems or C:\Program Files 
(x86)\ EksigentNanoLC on 64-bit operating systems.

b. Copy the Settings folder to the thumb drive.

3. Export the system settings .reg file on the current computer to the thumb drive.

a. Start the Eksigent control software.
b. Select System > Instrument Configuration.
c. Click Export Settings in the lower left corner (Figure 4-30). 

All instrument settings are exported to C:\Program Files\Eksigent 
NanoLC\settings\EkSettings.reg.

d. Copy the EkSettings.reg file to the thumb drive.

Required Materials
• Eksigent control software CD

• Thumb drive 

Note: Use the procedure below when you plan to use the same version of the 
Eksigent control software on the new computer. To update the Eksigent control 
software as part of the move to a new computer, follow the instructions provided with 
the software update.
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86 of 140 RUO-IDV-05-1129-B | D5033433 G



Routine Maintenance
4. Copy the Settings folder to the new computer.

a. Insert the thumb drive into the new computer.
b. Create the EksigentNanoLC folder on the new computer in the following 

directory:

• For 32-bit operating systems—C:\Program Files\EksigentNanoLC 

• For 64-bit operating systems—C:\Program Files (x86)\ EksigentNanoLC

c. Copy the Settings file from the thumb drive to the EksigentNanoLC folder.

5. Install the Eksigent control software on the new computer.

a. Turn off the power to the Eksigent MicroLC 200 Plus system.
b. Insert the Eksigent Control Software CD into the CD drive and follow the 

instructions to install the software.

6. Load the settings from the EKSettings.reg file.

a. From the Start menu, select Eksigent > Driver Configuration. 
If the User Account Control dialog appears, click Yes to continue.

b. Click Calibration Disk and navigate to the EkSettings.reg file on the thumb 
drive.

c. In the Analyst section, select Eksigent System Driver.

Figure 4-30 Instrument Configuration Dialog

Note: If an EksigentNanoLC folder is already present on the new 
computer, it indicates the Eksigent control software is probably already 
installed. Back up the Settings folder on the new computer to a safe 
location before proceeding to the next step.
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d. Click OK.

7. Copy the .cyx file from the thumb drive to the D:\Analyst Data\Projects\API 
Instrument\LC Devices\CTC PAL folder.

8. Before using the system, Re-initialize the Pressure Transducers.

Troubleshooting a Move to a New Computer

Problems with the Hardware Profile in the Analyst Software

Sometimes the hardware profile in the Analyst software on the new computer does not activate 
due to the autosampler. 

1. On the existing computer, locate the most recent version of the pal.pol file in the 
D:\Analyst Data\Projects\API Instrument\LC Devices\CTC PAL folder and copy it to a 
thumb drive.

2. On the new computer, copy the .pol file from the thumb drive to D:\Analyst 
Data\Projects\API Instrument\LC Devices\CTC PAL folder.

3. Follow the steps in Verify the Analyst Software Hardware Profile on page 16, to 
make sure the hardware profile specifies the correct COM port for the autosampler.

Note: If the Analyst section is unavailable, this means the Analyst 
software is not installed. Install the Analyst software and repeat step 6.

Figure 4-31 Eksigent Driver Configuration Utility
Eksigent MicroLC 200 Plus System Operator Guide
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Problems with the Gain and Integral Settings for the Pump

If the flow is not stable or you hear the sound of gas venting when the pumps are on, this could 
be due to a problem with the integral and gain settings. Follow the instructions below to 
troubleshoot this problem. 

1. On the new computer, in the Eksigent control software, select System > Hardware 
Diagnostics and then click the Calibration Values tab. 

2. Record the gain and integral (int) settings in the Control Parametres section near 
the bottom of the tab.

3. Repeat the previous steps on the new computer and compare the values for the two 
computers.

The first two digits in each value should be the same. If the values are not the same, 
contact AB SCIEX Technical Support.

Problems with Recognizing the COM Port on the New Computer

If a message indicating an instrument is not connected appears when the Eksigent control 
software is started (Figure 4-34), the COM port setting may not be correct. To set the COM port:

1. Turn on the Eksigent MicroLC 200 Plus system. 

a. Turn on the Eksigent power supply using the power switch on the back of the 
power supply.

b. Turn on the Eksigent MicroLC 200 Plus system using the power switch on the 
back of the unit.

2. Wait for Windows to display the new device installed dialog, and then click OK.

3. Identify the COM port the system is connected to.

a. Click Control Panel > System > Hardware (Figure 4-32).

Figure 4-32 System Properties Window—Hardware Tab
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b. Click Device Manager to open the Device Manager window (Figure 4-33).

c.  Expand the Ports (COM & LPT) section in the Device Manager window. 
The three USB serial ports shown are the COM ports associated with the 
Eksigent MicroLC 200 Plus system. The number assigned to the serial port 
differ from PC to PC. The first USB serial port is assigned to the Eksigent 
MicroLC 200 Plus system The second and third serial ports are assigned to 
RS 232 (A) and RS 232 (B), respectively. 
COM ports above 16 are not recognized. If this happens it is likely that lower 
COM port number assignments will have to be freed up from software.

 

d. Note the number of the first port for use below.

4. Open the Eksigent control software.

The No Instrument Connected dialog appears (Figure 4-34).

5. Click Cancel.

The Eksigent control software Acquisition window appears.

Figure 4-33 Device Manager Window

Tip!  AB SCIEX recommends that the autosampler be connected to 
RS 232 (A).

Figure 4-34 No Instrument Detected Dialog
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6. In the Acquisition window, click System > Instrument Configuration to display the 
Instrument Configuration dialog (Figure 4-35).

7. In the COM port list, select the COM port that is connected to the system.

8. Click OK.

The Re-start Required dialog appears.

9. Click OK to automatically quit the software.

Store the System
Before storing the system, do the following:

1. Change the mobile phases to an alcohol or acetonitrile.

2. Purge and flush the system to remove all water and mobile phases.

Figure 4-35 Instrument Configuration Dialog—System Tab
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5
Troubleshooting
Troubleshooting Overview
When troubleshooting the Eksigent MicroLC 200 Plus system, follow these safety practices:

Caution: Potential System Damage: There are no user-serviceable components or 
assemblies inside the Eksigent MicroLC 200 Plus system. Service of any internal parts or 
assemblies requires an AB SCIEX trained Field Service Employee.

The basic steps for troubleshooting are:

1. Step back and look at the overall system. Is something obvious causing the 
problem? For example, is the instrument unplugged or improperly connected?

2. Compare the current system operation with the way the system operated before the 
problem started. Identify conditions such as pressures, power settings, or flow rates 
that are different from when the system was operating normally.

For example, if the output pressure is usually 2500 psi for a certain method, is the 
system pressure currently in the same range, or drastically higher or lower?

3. In the order listed below, identify any symptoms which vary from normal system 
operation:

• System power on and initialization (initialization fails)

• System diagnostics (flow stability, controller tuning)

• Flow rate in each channel (high, low, erratic)

• Output pressure (high, low, erratic)

4. For each symptom, perform the corrective actions in the troubleshooting tables 
which follow. 

If this process does not correct the problem, contact AB SCIEX Technical Support.

WARNING! Electrical Shock Hazard: To avoid damaging electrical parts, do not 
disconnect an electrical assembly while power is applied to the HTC-xt PAL 
autosampler. Once the power is turned off, wait approximately 30 seconds before 
disconnecting an assembly.

 

WARNING! Biohazard or Toxic Chemical Hazard: When replacing tubing or 
fittings on the Eksigent MicroLC 200 Plus system or the HTC-xt PAL autosampler, 
exposure to solvents may occur. Follow appropriate safety procedures and use 
personal protective equipment according to the applicable Safety Data Sheets 
supplied by the solvent vendor. 
Operator Guide Eksigent MicroLC 200 Plus System
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Testing Fluid Connections

Follow the instructions below to identify leaks or clogs in the system.

1. Disconnect all the exits in the flow path, then sequentially connect them, one by one, 
starting at the pump.

2. Set the flow conditions to 40 µL/min with a 50% A:50% B isocratic and start the 
pump.

3. Compare the pressure to the value in Figure 5-1.

Ensure that the vial is in place before staring the pump.

• If the pressure is close to the value, the system is working as expected.

• If the pressure is higher, there may be a clog.

• If the pressure is low, there may be a leak. 

4. Stop the flow.

5. Connect the next item in the flow path, start the pump, and measure the pressure. 

• If the pressure is close to the value, the system is working as expected.

• If the pressure is higher, there may be a clog.

• If the pressure is low, there may be a leak. 

Repeat for all the components in the flow path, including the column and the ion 
source.

6. Stop the flow.

WARNING! Biohazard or Toxic Chemical Hazard: To avoid exposure to solvents 
when testing the fluid connections, be sure to have a vial or other container 
available to collect the solvent leaving the system.

Note: Column pressure (Pc) will vary with the composition of the mobile phase. More 
viscous mobile phases will result in higher pressure.
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Figure 5-1 Expected Pressure Changes Across the Eksigent MicroLC 200 Plus system—
Flow Rate 40 µL/min with a 50% A (Water):50% B (Acetonitrile) 

Item Description Pressure
(psi)

Total 
Pressure 
(Pc) (psi)

System Plumbed for 65 µm ID Electrode
1 Mixer-to-valve assembly 37 37

2 2 µL PEEKsil sample loop 1 38

3 30 cm of 50 µm ID PEEKsil tubing 315 353

4 0.5 x 50 mm 2.7 µm HALO fused C18 column 3200 3553

5 5 cm of 50 µm ID PEEKsil tubing 32 3585

6 In-line filter ~0 3585

7 5 cm of 50 µm ID PEEKsil tubing 32 3617

8 65 µm ID electrode 44 3661

Other Components
9 5 cm of 25 µm ID PEEKsil tubing 504 N/A

10 25 µm ID electrode 2017 N/A

11 50 µm ID electrode 126 N/A

(not shown) 5 µL PEEKsil sample loop ~0 N/A

(not shown) 10 cm of 50 µm ID PEEKsil tubing 63 N/A

(not shown) 10 cm of 25 µm ID PEEKsil tubing 1009 N/A

1

2
3

4 5

10
9

6

11
5

7 8

9

5
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Troubleshooting Tables
• Table 5-1 System Initialization on page 96

• Table 5-2 Flow Control System on page 96

• Table 5-3 Column Oven on page 99

• Table 5-4 Autosampler on page 100

• Table 5-5 Injection Valve on page 100
>

Table 5-1 System Initialization

Symptom Possible Cause Corrective Action
Power LED on front panel 
is not on.

Power supply is not turned on Turn on the power supply.

No power at outlet Repair the electrical outlet.

Power LED has failed but 
system response OK

Contact AB SCIEX Technical 
Support for assistance.

No Instrument Detected 
dialog or “Not connected” 
in Acquisition window. 

Communication error between 
computer and LC system

Verify the instrument USB cable 
is securely connected to the 
computer USB port.

Reboot the computer and cycle 
the power on the instrument.

In the list of COM ports in the 
Windows Device Manager 
dialog, verify the number 
assigned to the COM port is less 
than 16. 

If not, re-assign the COM port 
with a lower number.

Contact AB SCIEX Technical 
Support for assistance.

Loud hissing sound from 
the instrument.

Air leaks from the air inlet fitting Verify the air tubing is properly 
connected to the gas fitting.

Tighten the air inlet gas fitting.

Contact AB SCIEX Technical 
Support for assistance.

Table 5-2 Flow Control System

Symptom Possible Cause Corrective Action
System pressure (Pc) and/
or pump pressures (Pa & 
Pb) show pressure though 
the flow is off

Incorrect zero setting for 
pressure sensors

Re-initialize the pressure 
transducers (refer to Re-initialize 
the Pressure Transducers on 
page 52).
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No liquid out of waste line 
when purging

Air trapped in the pump Purge and flush the system 
(refer to Purge Mobile Phases 
on page 51).

Internal filters are plugged Contact AB SCIEX Technical 
Support for assistance.

Leak in the system prior to the 
purge valve

Check all connections.

Pump restrokes frequently 
(“Pump has reached end 
of stroke” error message 
appears)

Air trapped in the pump Purge the pump (refer to step 3 
in Purge Mobile Phases on 
page 51).

Pump remains on long enough 
to prompt a restroke

For the current flow rate, 
calculate the time to pump 
~600 µL. Verify that the pump 
restrokes at approximately that 
time interval.

Check valve is leaking Contact AB SCIEX Technical 
Support for assistance.

Pump does not re-stroke 
at the end of a run.

Pump restroke delay is too short Contact AB SCIEX Technical 
Support for assistance.Optical sensor not working 

correctly

Pump flushes quickly but 
does not deliver ~600 µL 
per stroke

Leak in instrument Contact AB SCIEX Technical 
Support for assistance.

Purge output drips slowly Internal filters are plugged Contact AB SCIEX Technical 
Support for assistance.

No flow rate with 100% 
power indicated. System 
pressure (Pc) and pump 
pressures (Pa and Pb) are 
all low.

No air to system Connect 100 psi clean, dry air to 
the instrument air inlet.

System not properly purged and 
flushed

Purge and flush the system 
(refer to Purge Mobile Phases 
on page 51).

Inability to reach desired 
flow rate

Internal filters are plugged Contact AB SCIEX Technical 
Support for assistance.

Flow rate setpoint too high for 
system back pressure

In the Direct Control dialog, 
decrease the flow rate.

Air pressure too low Verify that the air supply has an 
air pressure of 100 psi.

Table 5-2 Flow Control System (Continued)

Symptom Possible Cause Corrective Action
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Flow rate will not initialize 
at start of run

Flow rate setpoint too high off 
system back pressure

In the Direct Control dialog, 
decrease the flow rate.

Bubbles in the system causing 
erratic flow rate

Purge and flush the system 
(refer to Purge Mobile Phases 
on page 51).

Unable to meet required flow 
rate within specified tolerance

Lower the flow stabilization limit 
in the Advanced tab of the 
Instrument Configuration 
dialog of the Eksigent control 
software.

Internal filters are plugged Purge the system (refer to Purge 
Mobile Phases on page 51) and 
inspect the flow through the 
waste tubing after ~8 purges. 

If the flow is very low or 
intermittent, the filter should be 
changed. Contact AB SCIEX 
Technical Support for 
assistance.

Flow rate will not stabilize 
during a run

Erratic flow rate due to bubbles 
in system

Purge and flush the system 
(refer to Purge Mobile Phases 
on page 51).

Incorrect mobile phase setting Check the settings in the Mobile 
Phases dialog and modify as 
needed.

Pump controller out of tune Contact AB SCIEX Technical 
Support for assistance.

Flow temperature is not stable Contact AB SCIEX Technical 
Support for assistance.

System responds 
sluggishly when changing 
flow rates

Incorrect mobile phase setting Check the settings in the Mobile 
Phases dialog and modify as 
needed.

Pump controller out of tune Contact AB SCIEX Technical 
Support for assistance.

Inaccurate flow rate with 
no signs of leakage

Incorrect mobile phase setting Check the settings in the Mobile 
Phases dialog and modify as 
needed.

Incorrect k-values Calibrate the flowmeters (refer to 
Calibrate Flowmeters on 
page 54).

System pressure (Pc) is 
unusually low but flow rate 
is OK

Loose connection after mixing 
tee

Check all connections for leaks.

Table 5-2 Flow Control System (Continued)

Symptom Possible Cause Corrective Action
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System pressure (Pc) is 
low and flow rate is OK but 
pump pressures (Pa and 
Pb) are high

Incorrect k-values Calibrate the flowmeters (refer to 
Calibrate Flowmeters on 
page 54).

Flow module is plugged Contact AB SCIEX Technical 
Support for assistance.

System pressure (Pc) is 
very high

Tubing or fitting is plugged Starting at the waste tanks, 
remove each tube or fitting, one 
at a time, until the pressure 
drops dramatically. Replace the 
plugged item.

Excess flow noise Trapped air in pump Purge the pumps (refer to step 3 
in Purge Mobile Phases on 
page 51).

Pump controller out of tune Contact AB SCIEX Technical 
Support for assistance.

Measured flow does not 
follow the flow profile

Pump controller out of tune Contact AB SCIEX Technical 
Support for assistance.

Pump time response is set 
incorrectly

Adjust the pump time response 
in the Flow Metering and 
Control section of the Hardware 
Diagnostics dialog.

Pump pressures (Pa and 
Pb) maximized to 
<12 000 psi at 100% pump 
power

Incorrect gain setting for 
pressure

Verify the pump pressures are 
2800 psi/V in the Calibration 
Values tab of the Hardware 
Diagnostics dialog.

Incorrect zero setting for 
pressure sensors

Re-initialize the pressure 
transducers (refer to Re-initialize 
the Pressure Transducers on 
page 52).

In-line air pressure too low. Verify that the air supply has an 
air pressure of 100 psi.

Table 5-3 Column Oven

Symptom Possible Cause Corrective Action
Column responds very 
slowly when changing 
temperature

Oven malfunction Contact AB SCIEX Technical 
Support for assistance.

Temperature reads 47 Oven unplugged Verify the column oven is 
plugged in.

Table 5-2 Flow Control System (Continued)

Symptom Possible Cause Corrective Action
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Table 5-4 Autosampler

Symptom Possible Cause Corrective Action

Eksigent control software 
does not recognize HTC-xt 
PAL autosampler when 
Run Manager starts

Communication error between 
autosampler and computer

Verify the RS-232 cable is 
securely connected to the 
autosampler communication 
port.

Software may be configured to 
use a different COM port than 
the autosampler is using

Determine which COM port is 
configured for the software in the 
System tab of the Instrument 
Configuration dialog of the 
Eksigent control software. If 
needed, select a different port.

“Autosampler not 
recognized” message 
when activating the 
hardware profile in the 
Analyst® software 

Communication problem 
between autosampler and the 
Analyst software

Power cycle the autosampler 
and try again to reactivate the 
hardware profile.

Table 5-5 Injection Valve

Symptom Possible Cause Corrective Action
Injection valve does not 
switch positions

Valve is not configured in 
Eksigent control software

Select Eksigent Internal in the 
Injection Valve list in the 
System tab of the Instrument 
Configuration dialog of the 
Eksigent control software.

Valve is not connected to the 
actuator

Contact AB SCIEX Technical 
Support for assistance.

Actuator is faulty

No flow coming out of the 
port

Valve is plumbed incorrectly Verify the plumbing configuration 
and reconfigure if needed (refer 
to Plumb the Injection Valve on 
page 61).

Ports are plugged Use a syringe to manually flush 
each port with cleaning solvent.

If flushing does not clean the 
port, contact AB SCIEX 
Technical Support for 
assistance.
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When no column is 
connected, system 
pressure (Pc) is unusually 
high

Ports are plugged Use a syringe to manually flush 
each port with cleaning solvent.

If flushing does not clean the 
port, contact AB SCIEX 
Technical Support for 
assistance.

Ends of tubing crushed Replace tubing and do not over-
tighten fittings.

Fluid leaking from the 
valve

Ferrule not properly seated in 
the port

Check the tubing connection and 
verify the ferrule is properly 
seated.

Rotor seal is scratched Replace the rotor seal (refer to 
Replace the Injection Valve 
Rotor Seal on page 58).

Inconsistent flow rate Internal leakage in valve Contact AB SCIEX Technical 
Support for assistance.

Ports are plugged Use a syringe to manually flush 
each port with cleaning solvent.

If flushing does not clean the 
port, contact AB SCIEX 
Technical Support for 
assistance.

System does not initiate an 
injection

System flow is unstable Purge the pumps and re-
equilibrate the system.

Flow stabilization set too low Set the flow stabilization limit 
>100 nL/min in the Advanced 
tab of the Instrument 
Configuration dialog of the 
Eksigent control software.

Autosampler configured to wait 
for injection but the Sample 
Injection setting in the Eksigent 
control software is “None”

In the LC Method Settings 
dialog, change Sample 
Injection to a value other than 
None.

Pressure drops at the 
beginning of each run

Air bubbles in sample loop In the Analyst software, edit the 
autosampler method to make 
sure the loop is completely filled 
with sample. Either:

• In the Cycle Arguments 
table, set the Front Volume 
and Rear Volume > 0.

• Specify an Injection Volume 
greater than the volume of the 
sample loop.

High relative standard 
deviation between peak 
areas for successive runs

Table 5-5 Injection Valve (Continued)

Symptom Possible Cause Corrective Action
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A
Principles of Operation
The Eksigent MicroLC 200 Plus system is an ultra high-pressure liquid chromatography (UHPLC) 
system optimized for ultra-fast LC/MS analysis using 0.3 mm to 1.0 mm ID columns.The system 
incorporates microfluidic flow control (MFC) to generate precise LC gradients at microflow rates. 
The system also includes the HTC-xt PAL autosampler with dynamic load and wash (DLW), a 
sample injection system designed to minimize sample carryover.

This appendix contains the following sections:

• Microfluidic Flow Control

• Guidelines for Micro UHPLC Methods

• Dynamic Load and Wash

• Autosampler Method

Microfluidic Flow Control
MFC has two primary benefits:

• precise gradients at microliter-per-minute rates without flow splitting

• extremely rapid response to setpoint changes enabling fast gradients and dynamic 
flow control

The components of a binary gradient MFC system are shown schematically in Figure A-1.

Figure A-1 Schematic Drawing of Microfluidic Flow Control (MFC) System Components

Item Description
1 Electronically controlled pressure source

2 Proportional-integral-derivative (PID) controller

3 Flowmeter

1

3

5

2

2

3 1

4
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How the MFC System Works
For each mobile phase:

1. The flowmeter continuously monitors the flow rate and sends a signal to the PID 
controller (refer to Calculating the Flow Rate).

A PID controller is a control loop feedback device that automatically adjusts one 
variable in a system in an attempt to hold another variable at a specified setpoint. 
For the Eksigent MicroLC 200 Plus system, the controller adjusts the pressure in 
order to maintain the specified flow rate.

2. The PID controller sends a voltage signal to the pressure source. 

The signal is proportional to the pressure required for the desired flow rate during the 
gradient (refer to Pressure Required to Generate a Gradient on page 105).

3. The pressure source changes the pressure to generate the required flow rate.

Pressure in the system is generated by connecting laboratory air or nitrogen to a 
pneumatic amplifier. For example,100 psi incoming air pressure from the laboratory 
air system can be used to produce hydraulic pressure ranging from 0 psi to >10 000 
psi.

Calculating the Flow Rate
The flow rate of each mobile phase is determined by measuring the differential pressure, P, 
across a calibration module of known geometry (item 3 in Figure A-1). 

Flow rate, Q, is given as:

Q = k P/µ

where

k = flow conductance—determined by the flowmeter calibration

P = differential pressure—measured at the flow module

µ = pressure-corrected viscosity of the mobile phase—from the Eksigent control 
software

The flow conductance (k) is measured and corrected using the flowmeter calibration in the 
Eksigent control software. This calibration is part of routine maintenance for the system (refer to 
Calibrate Flowmeters on page 54).

The flow rate measurement is determined for the individual mobile phases by measuring P.

Viscosity for a given mobile phase is a function of pressure, temperature, and the composition of 
the mobile phase. The Eksigent control software contains mixture viscosity parameters for a wide 
variety of frequently used mobile phases. Because the temperature at the flowmeter is 
controlled, eliminating the need for temperature-correction.

4 Mixing tee

5 Column

Item Description
Eksigent MicroLC 200 Plus System Operator Guide
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Pressure Required to Generate a Gradient
For a run, the total flow rate through the column, QCOL, and the gradient profile are specified. 
From the gradient profile, the system can calculate the percentage of each mobile phase (and 
thus the required flow rate) at any point during the gradient.

Knowing the viscosities, flow conductances, and flow rates of each mobile phase, and the 
pressure at the head of the column (Pc), the setpoint pressures for mobile phase a (Pa) and 
mobile phase b (Pb) can be calculated. The microfluidic flow controllers maintain these setpoints 
and adjust the pressure as needed to change the flow rate of each mobile phase over the 
duration of the gradient.

For a typical water-acetonitrile gradient, Pc changes during the run due to the increased volume 
of acetonitrile as the gradient progresses. Figure A-2 shows how viscosity changes based on the 
percentage of acetonitrile.

Pressure and flow rate for the system and each mobile phase can be viewed in the status area 
(Figure A-3) of the Acquisition window in the Eksigent control software (Figure A-4).

Figure A-2 Viscosity as a Function of Acetonitrile % for a Water-acetonitrile Mixture

Figure A-3 Detail of Status Area in the Eksigent Control Software
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Use the Appearance Settings dialog (accessed from System > Appearance Settings or by 
right-clicking the status bars) to select which parameters are displayed (Figure A-5).

Figure A-4 Acquisition Window

Figure A-5 Appearance Settings Dialog
Eksigent MicroLC 200 Plus System Operator Guide
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Dynamic Flow Control
In addition to precise control of gradients, the rapid pressure control of MFC also allows the flow 
rate to be changed dynamically during a gradient run. 

Figure A-6 shows how flow rate (Q) drops from 100 nL/min to 20 nL/min in less than 1 second at 
the flowmeter. The column capacitance typical delays this effect for less than 2 seconds at the 
electrode tip.

Guidelines for Micro UHPLC Methods
The smaller columns used in micro ultra-high performance liquid chromatography (UHPLC) 
require lower flow rates, smaller injection volumes, and different electrodes and tubing than 
traditional UHPLC. 

Flow Rate and Injection Volume

When converting a method from traditional UHPLC to micro UHPLC, flow velocity should be kept 
the same so that retention times do not change. 

Flow velocity, FV, is given by FV = Q x A, where:

Q = flow rate

A = cross-sectional area of the column

Table A-1 demonstrates how flow rate varies by column diameter for (approximately) the same 
flow velocity. The table also gives appropriate injection volumes. 

Figure A-6 Plot of Flow Rate Versus Time, Showing Rapid Response
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Principles of Operation
For other column diameters or other flow rates, a general guideline is that flow rate scales with 
the square of the column diameter. This is derived in detail below.

Determining Flow Rate for Different Columns

Consider converting a traditional UHPLC method to one for the Eksigent MicroLC 200 Plus 
system. Column a is used for traditional UHPLC, with a known flow rate (Qa). Column b will be 
used on the Eksigent MicroLC 200 Plus system. What is the flow rate for column b?

Because the columns should have the same flow velocity, the relationship shown in Figure A-7 is 
true. 

Figure A-7 Columns a and b with the Same Flow Velocity

Solving for the flow rate for column b (Qb) results in Figure A-8.

Figure A-8 Flow Rate for Column b

Because columns are usually specified by internal diameter (ID), it is more useful to express the 
cross-sectional area in terms of the column diameter, as shown in Figure A-9, where D is the 
column diameter.

Figure A-9 Column Cross-sectional Area in Terms of Diameter

Substituting the formula for column cross-sectional area into the equation for Qb gives Figure A-
10. 

Table A-1 Equivalent Flow Rates and Injection Volumes for Micro UHPLC

Column 
Diameter (mm)

Flow Rate 
(µL/min)

Injection 
Volume (µL)

Cross-sectional 
Area (mm2)

Traditional UHPLC
4.6 2100 200 16.62

2.1 450 40 3.46

Micro UHPLC
1.0 100 10 0.785

0.5 25 2.5 0.196

0.3 10 1.0 0.071

FV
Qa
Aa
------

Qb
Ab
------= =

Qb
Qa
Aa
------ Ab=

A  D
2
----

2
=
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Figure A-10 Flow Rate for Column b, Showing Cross-sectional Area Explicitly

Qb can be simplified to Figure A-11. As can be seen below, the flow rate for column b is 
proportional to the square of the column diameter.

Figure A-11 Flow Rate for Column b, Showing Relationship to Column Diameter

Electrodes and Tubing
When selecting an electrode for use with the Eksigent MicroLC 200 Plus system, it is important to 
balance peak spreading with back pressure on the system. In general, the smaller the electrode, 
the narrower the peak width (Figure A-12).

However, as flow rate increases so does the back pressure on the system. For example, at the 
relatively low flow rate of 20 µL/min, back pressure on a 25 µm diameter electrode can reach 
~1000 psi (Figure A-13) (dashed lines indicate appropriate flow rate ranges for 25 µm (red) and 
50 µm (brown) electrodes, green line shows pressure for a 100 µm diameter electrode for 
reference).

Figure A-12 Mass Spectrometer Peak Width for Different ESI Electrodes
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Use Table A-2 to select the appropriate electrode and tubing based on the column diameter. 
(Information for traditional UHPLC is given for reference.) 

Figure A-13 Back Pressure Versus Flow Rate for Different ESI Electrodes

Table A-2 Tubing, Flow Rates, and Electrodes for Micro UHLPC

Column 
Diameter 
(mm)

Flow Rate 
(µL/min)

Pre-column 
Tubing 
Diameter (µm)

Post-column 
Tubing 
Diameter (µm)

Recommended ESI 
Electrode

Traditional UHPLC
2.1 200 to 1000 ~125 (0.005 inch) ~125 (0.005 inch) Standard Turbo V electrode 

(100 µm ID)

Micro UHPLC
0.3 4 to 20 50 25 25 µm or 50 µm ID hybrid 

PEEKsil/stainless steel

0.5 10 to 50 50 25 or 50 50 µm ID hybrid PEEKsil/
stainless steel

1.0 50 to 200 50 50 65 µm ID stainless steel 
or 
50 µm ID hybrid PEEKsil/
stainless steel

0

100

200

300

400

500

600

700

800

900

1000

0 20 40 60 80 100 120 140 160 180 200

P
re

s
s

u
re

 (
p

s
i)

Flow Rate (μL/min)

ESI Probe Backpressures

25 μm

50 μm

65 μm

100 μm

Flow rate range for 50 μm electrodes

Flow rate range for 65 μm electrodes

Flow rate range for 25 μm electrodes
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Dynamic Load and Wash
The DLW (dynamic load and wash) feature on the HTC-xt PAL autosampler is designed to 
minimize sample carryover. Unlike conventional autosamplers, the sample is never in contact 
with the syringe. Instead, the sample only comes into contact with the needle and the holding 
loop. When the sample is aspirated, it is bracketed on both ends with a small volume of air which 
creates a barrier to prevent the diffusion of the sample into the wash solvent. The air also assists 
in cleaning the entire injection path. At the end of the injection cycle, all parts of the system which 
have been in contact with the sample are washed with both organic and aqueous wash solvents 
and are completely clean, resulting in near-zero carryover for most components.

Figure A-14 shows the DLW schematically, with sample indicated in red, wash solvent 1 
indicated in blue, and wash solvent 2 indicated in green. 
Operator Guide Eksigent MicroLC 200 Plus System
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Figure A-14 Schematic Drawing of the DLW

Item Description Item Description
1 Syringe 10 From pump

2 Solenoid/actuator valve 11 To column

3 Holding loop 12 Sample—located between front 
sample (item 9) and rear sample (item 
13); specified by Injection Volume 

4 Wash station 13 Rear sample—specified by Rear 
Volume

5 Wash solvent 2 waste 14 Rear airgap—fixed volume of 0.5 µL

6 Wash solvent 1 waste 15 DLW pump 2

7 To waste container 16 Wash solvent 2 (aqueous)

8 Front airgap—specified by Airgap 
Volume in the autosampler method

17 Wash solvent 1 (organic)

9 Front sample—specified by Front 
Volume

18 DLW pump1

1
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4

56

8

13

14

15
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16

17

7
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The DLW Process
1. Air and sample are aspirated in the needle and holding loop as shown in 

Figure A-15.

Bold text indicates volumes which can be set by the user.

2. The needle and holding loop, and their contents are moved to the injection port. 

3. The front airgap and front sample is dispensed immediately. 

4. When the Eksigent MicroLC 200 Plus pump is ready to start a run, the sample is 
dispensed and the valve is switched to inject the sample onto the column.

5. After the valve is switched, the entire sample path, including the valve and needle, is 
washed twice, first with the organic wash solvent and then with the aqueous solvent.

Figure A-15 Holding Loop and Syringe, Showing Location of Sample and 
Airgaps

Rear airgap volume (air)

Front Volume (sample)

Rear Volume (sample)

Injection Volume (sample)

Airgap Volume (air)

Holding loop
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Sample Position in the Sample Loop

Ideally, the injection volume is injected exactly into the sample loop. In reality, the injection 
volume is often slightly offset. Therefore, the front and rear volume are used to ensure the loop is 
full with sample. This is illustrated schematically in Figure A-16, where:

• Blue—air (front air gap and rear air gap)

• Yellow—sample (rear volume)

• Orange—sample (injection volume)

• Pink—sample (front volume)

Even when the injection volume is not located exactly in the sample loop, the presence of the 
front and rear volume ensures that the entire volume injected onto the column contains sample. 

Because the front and rear volumes can be set to 0 by the user in the autosampler method in the 
Analyst® software, it is possible that the volume injected onto the column can include an air 
bubble. This is illustrated schematically in Figure A-17, where blue represents air and orange 
represents the injection volume.

Communicating with the DLW
The Analyst® software uses the autosampler method to communicate with the HTC-xt PAL 
autosampler and the DLW. The autosampler method is part of the acquisition method. 

The Available Cycles field in the CTC PAL Autosampler Basic Properties tab of the 
Acquisition Method window (Figure A-18) lists the available autosampler methods. The 
appropriate method for the HTC-xt PAL autosampler is “microLC200-Injection-Rev B” and is 
installed with the Eksigent MicroLC 200 Plus system. 

Figure A-16 Possible Locations of Sample in Loop, Front and Rear Volume >0

Figure A-17 Possible Locations of Sample in Loop, Front and Rear Volume = 0

Sample    Loop                  

Injection volume exactly in loop

Injection volume offset, rear volume follows sample

Injection volume offset, front volume precedes 
sample

Flow                  

Sample    Loop                  

Injection volume exactly in loop

Injection volume offset, air bubble follows sample

Injection volume offset, air bubble precedes sample

Flow                  
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Autosampler Method
The autosampler method consists of the steps below. In the method itself, some of the major 
steps are grouped together as routines so they can easily be repeated. The name of the routine 
is shown in parentheses after the step.

1. Lock the handheld terminal on the autosampler.

2. Wait for a signal from the mass spectrometer (Instrument Ready routine).

3. Aspirate the sample (Load Sample routine), then:

a. Dip the needle in organic wash solvent 1 (Needle Dip 1 routine).
b. Dip the needle in organic wash solvent 2 (Needle Dip 2 routine).

4. Move the needle into the injection port on the valve. 

5. Load sample into the injection loop, then switch the valve to inject sample onto the 
column (Inject Sample routine).

6. Wash the system (Clean System routine):

• Wash the injection valve and needle with the specified wash solvent (typically 
the organic wash solvent).

Figure A-18 CTC PAL Autosampler Basic Properties Tab in the Acquisition Method 
Window, Showing microLC200-Injection-Rev B 

h2
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• Wash the needle and injection valve with specified wash solvent (typically the 
aqueous solvent).

7. Optionally, wash the injection valve and needle again with the specified wash solvent 
(typically the organic wash solvent) (Final Clean routine).

8. Move the needle to the home position. 

9. Unlock the handheld terminal on the autosampler.

The autosampler method is used both when acquiring data and when equilibrating the mass 
spectrometer. During equilibration, the Instrument Ready, Get Sample, Inject Sample and Final 
Clean routines are not executed. When the mass spectrometer is acquiring data, the entire 
autosampler method is executed for each sample injection except for the Final Clean routine, 
which is omitted by default.

Parameters for the Autosampler Method
The volumes shown in bold in Figure A-15 on page 113, as well parameters influencing the 
timing of the DLW are set in Cycle Arguments table of the Acquisition Method window. The 
default values for most of the parameters, as well as their ranges, are listed in Table A-3.

Table A-4 and Table A-5 describe where the parameters are used.

Table A-3 Parameters in the Cycle Arguments Table

Parameter Default Value Minimum Maximum
Airgap Volume (µL) 1 0.01 SYR.Max Volume

Front Volume (µL) 0 0 SYR.Max Volume

Rear Volume (µL) 0 0 SYR.Max Volume

Sample Aspirate Speed (µL/s) 2 SYR.Min Speed SYR.Max Speed

Pullup Delay (ms) 500 0 20 000

Num of Wash1 PreDips 1 0 2

Num of Wash2 PreDips 0 0 2

Inject to LCVlv1

Injection Speed (µL/s) 1 SYR.Min Speed SYR.Max Speed

Needle Gap for Vlv Cleans (mm) 0 0 35

First Wash Solvent Wash1 Wash1 or Wash 2

Valve Clean Time 1 (s) 5 0 100

Needle Clean Time 1 (s) 2 0 10

Second Wash Solvent Wash1 Wash1 or Wash 2

Needle Clean Time 2 (s) 2 0 10

Valve Clean Time 2 (s) 5 0 100

Replicate Count 1 0 10

Final Wash Solvent Wash1 Wash1 or Wash 2

0 or 1 Final Cleans 0 0 1

Final Needle Clean Time (s) 2 0 10
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For more details of the autosampler method, refer to the following sections.

Autosampler Method, Step-by-Step
All of the steps in the method are listed in Table A-4. Each step is described generally and with 
details specific to the microLC200-Injection-Rev B method. Routines begin with the REPEAT 
step and end with END. User-settable parameters (from the CTC PAL Autosampler Basic 
Properties tab) are shown in bold text.

For the actual parameters and values used by each step in the method, refer to Table A-5 on 
page 121.

Final Valve Clean Time (s) 5 0 10

Note: Values prefixed with “SYR.” can be set in the autosampler using the keypad 
terminal, but the default values should be appropriate for the majority of situations.

Table A-4 microLC200-Injection-Rev B Autosampler Method 

Step Step Name General Description Detailed Description
1 LOCK_TERMINAL Lock or unlock the handheld 

terminal
Terminal is locked.

R
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y 
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e

2 REPEAT Begin a routine to be 
executed a specified 
number of times

During equilibration, this routine 
is skipped.

During normal operation, this 
routine is run once.

3 WAIT_FOR_DS Wait for response from 
mass spectrometer 
indicating it is ready

Allows the mass spectrometer 
to equilibrate for experiments 
which switch between positive 
and negative mode during a 
run.

4 END End a routine started with 
REPEAT

Table A-3 Parameters in the Cycle Arguments Table (Continued)

Parameter Default Value Minimum Maximum
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5 REPEAT Begin a routine to be 
executed a specified 
number of times

During equilibration, this routine 
is skipped.

During normal operation, this 
routine is run once.

6 WAIT_SYNC_SIG Wait for a sync signal Wait for the “Start” sync signal 
from the pump telling the 
autosampler to start. This is a 
software trigger.

7 ASPIRATE_SYR Raise syringe plunger to 
aspirate a specified volume

This aspirates the rear airgap, a 
fixed value of 0.5 µL.

8 GET_SAMPLE Fill syringe from a selected 
tray, vial or wash station

The Rear Volume, Injection 
Volume, Front Volume, and 
Airgap Volume enter the DLW 
holding loop at the specified 
Filling Speed and Pullup 
Delay.

Needle Dip 1 Routine

9 REPEAT Begin a routine to be 
executed a specified 
number of times

During equilibration, this routine 
is skipped.

During normal operation, Num 
of Wash1 PreDips specifies if 
this routine is run.

10 MOVETO_OBJECT Move to a specified position 
such as a vial, tray, wash 
station, or injector, with a 
specified needle penetration

Injection unit moves to Wash1 
and dips the needle in wash 
solvent 1.

11 END End a routine started with 
REPEAT

Ends Needle Dip 1 routine.

Needle Dip 2 Routine

12 REPEAT Begin a routine to be 
executed a specified 
number of times

During equilibration, this routine 
is skipped.

During normal operation, Num 
of Wash2 PreDips specifies if 
this routine is run. By default, 
this routine is skipped.

13 MOVETO_OBJECT Move to a specified position 
such as a vial, tray, wash 
station, or injector, with a 
specified needle penetration

Injection unit moves to Wash2 
and dips the needle in wash 
solvent 2.

14 END End a routine started with 
REPEAT

Ends Needle Dip 2 routine.

15 END End a routine started with 
REPEAT

Ends Load Sample routine.

Table A-4 microLC200-Injection-Rev B Autosampler Method  (Continued)

Step Step Name General Description Detailed Description
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16 MOVETO_OBJECT Move to a specified position 
such as a vial, tray, wash 
station, or injector, with a 
specified needle penetration

Injection unit moves to LC Vlv1.
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17 REPEAT Begin a routine to be 
executed a specified 
number of times

During equilibration, this routine 
is skipped.

During normal operation, the 
routine is run once.

18 WAIT_EVENT Wait until specified event 
has the specified state

Wait for the “TTL-In1” event to 
enter the “On” state. This is an 
input event when the pumps tell 
the autosampler that they are 
on. 

This is connected to “RDY 
OUT” on the rear of the LC 
pumps. The LC should be set to 
pull it low for “On”.

19 DISPENSE_SYR Lower plunger to dispense a 
specified volume

The Injection Volume, Front 
Volume, and Airgap Volume 
are dispensed through the 
injection loop to waste at the 
specified Injection Speed

20 SWITCH_EVENT Change the state of an 
output event

The event “SW-Out1” is set to 
“On” and pulsed for 500ms. 

For troubleshooting, “SW-Out1 
NO” (red wire) and “SW-Out1 
COM” (black wire) are 
connected to “RUN IN” and 
“CMN” respectively on the rear 
of the pump.

21 SET_INJECTED Fires an event after 
completion of a sample 
handling or injection step

This event allows other steps in 
the autosampler firmware to be 
synchronized to an injection.

22 WAIT_EVENT Wait until specified event 
has the specified state

Wait for the event “TTL-In2” to 
enter the “On” state. 

“TTL-In2” is connected by the 
blue wire to “VLV OUT” on the 
rear of the pump. “VLV OUT” is 
pulled low when the injection 
valve is in the Inject state.

23 EJECT_SYR Dispense the entire syringe 
volume

24 END End a routine started with 
REPEAT

Ends Inject Sample routine.

Table A-4 microLC200-Injection-Rev B Autosampler Method  (Continued)

Step Step Name General Description Detailed Description
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REPEAT Begin a routine to be 
executed a specified 
number of times

This routine rinses the valve 
and the syringe. Replicates 
specifies how many times the 
routine runs.

26 RINSE_INJ Rinse the injection valve 
with the specified wash 
solvent for the specified 
duration

Solvent is specified by First 
Wash Solvent, duration of 
rinse by Valve Clean Time 1.

27 CLEAN_SYR Rinse the syringe with the 
specified wash solvent for 
the specified duration

Solvent is specified by First 
Wash Solvent, duration of 
rinse by Needle Clean Time 1.

28 CLEAN_SYR Rinse the syringe with the 
specified wash solvent for 
the specified duration

Solvent is specified by Second 
Wash Solvent, duration of 
rinse by Needle Clean Time 2.

29 RINSE_INJ Rinse the injection valve 
with the specified wash 
solvent for the specified 
duration

Solvent is specified by Second 
Wash Solvent, duration of 
rinse by Valve Clean Time 2.

30 END End a routine started with 
REPEAT

Ends Clean System Routine.
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31 REPEAT Begin a routine to be 
executed a specified 
number of times

During equilibration, this routine 
is skipped.

During normal operation, 0 or 1 
Final Cleans specifies if this 
routine is run.By default, this 
routine is skipped.

32 CLEAN_SYR Rinse the syringe with the 
specified wash solvent for 
the specified duration

Solvent is specified by Final 
Wash Solvent, duration of 
rinse by Final Needle Clean 
Time.

33 RINSE_INJ Rinse the injection valve 
with the specified wash 
solvent for the specified 
duration

Solvent is specified by Final 
Wash Solvent, duration of 
rinse by Final Valve Clean 
Time.

34 END End a routine started with 
REPEAT

Ends Final Clean Routine.

35 MOVETO_OBJECT Move to a specified position 
such as a vial, tray, wash 
station, or injector, with a 
specified needle penetration

Injection unit moves to home 
position.

36 LOCK_TERMINAL Lock or unlock the handheld 
terminal

Terminal is unlocked.

Table A-4 microLC200-Injection-Rev B Autosampler Method  (Continued)

Step Step Name General Description Detailed Description
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Parameters and Values in the Autosampler Method
For each step in the autosampler method, Table A-5 shows the parameters and their values.

As before, the user-settable parameters are shown in bold text.

Table A-5 Parameters and Values for the microLC200-Injection-Rev B Autosampler 
Method 

Step Step Name Parameter Value
1 LOCK_TERMINAL Terminal locking On

R
ea

d
y 

R
o

u
ti

n
e 2 REPEAT Count 1-SL.WashOnly

3 WAIT_FOR_DS

4 END
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5 REPEAT COUNT

6 WAIT_SYNC_SIG Sync Signal Start

7 ASPIRATE_SYR Volume (µL) Airgap Volume

Overfill Rate (%) 0

Fill Speed (µL/min) Sample Aspirate Speed

Pullup Delay (ms) Pullup Delay

8 GET_SAMPLE Source SL.Tray

Index SL.Index

Sample Volume (µL) Rear Volume + SL.Volume + Front 
Volume

(SL.Volume corresponds to the 
Injection Volume set in the Analyst 
software)

Air Volume (µL) Airgap Volume

Penetration (mm)

Fill Volume (µL)

Fill Speed (µL/min) Sample Aspirate Speed

Pullup Delay (ms) Pullup Delay

Eject Speed (µL/min)

Fill Strokes 0

Needle Blocking Off

Wait for Timer

Wait Time (sec)

Needle Dip 1 Routine

9 REPEAT Count Num of Wash1 PreDips

10 MOVETO_OBJECT Object Name Wash1

Index 1

Penetration (mm)

11 END

Needle Dip 2 Routine

12 REPEAT Count Num of Wash2 PreDips

13 MOVETO_OBJECT Object Name Wash2

Index 1

Penetration (mm)

14 END

15 END

Table A-5 Parameters and Values for the microLC200-Injection-Rev B Autosampler 
Method  (Continued)

Step Step Name Parameter Value
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16 MOVETO_OBJECT Object Name Inject to

Index 1

Penetration (mm) Object Name.Needle Penetr
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17 REPEAT Count 1-SL.WashOnly

18 WAIT_EVENT Event TTL-In1

Signal State On

19 DISPENSE_SYR Volume (µL) SL.Volume + Front Volume + Airgap 
Volume

Eject Speed (µL/sec) Injection Speed

20 SWITCH_EVENT Event SW-Out 1

Signal State On

Pulse Time (ms) 500

21 SET_INJECTED

22 WAIT_EVENT Event TTL-In2

Signal State On

23 EJECT_SYR Eject Speed (µL/sec) SYR.Eject Speed

24 END

Table A-5 Parameters and Values for the microLC200-Injection-Rev B Autosampler 
Method  (Continued)

Step Step Name Parameter Value
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25 REPEAT Count Replicate Count

26 RINSE_INJ Wash Station First Wash Solvent

Injector Inject to

Needle Gap (mm) Needle Gap for Vlv Cleans

Rinse Times (s) Valve Clean Time 1

27 CLEAN_SYR Wash Station First Wash Solvent

Clean Cycles 0

Clean Volume (%) 0

Wash Penetration (mm)

Fill Speed 100

Pullup Delay (ms) 0

Eject Speed 100

Rinse time (sec) Needle Clean Time 1

28 CLEAN_SYR Wash Station Second Wash Solvent

Clean Cycles 0

Clean Volume (%) 0

Wash Penetration (mm)

Fill Speed 100

Pullup Delay (ms) 0

Eject Speed 100

Rinse time (sec) Needle Clean Time 2

29 RINSE_INJ Wash Station Second Wash Solvent

Injector Inject to

Needle Gap (mm) Needle Gap for Vlv Cleans

Rinse Times (s) Needle Clean Time 2

30 END

Table A-5 Parameters and Values for the microLC200-Injection-Rev B Autosampler 
Method  (Continued)

Step Step Name Parameter Value
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31 REPEAT Count 0 or 1 Final Cleans

32 CLEAN_SYR Wash Station Final Wash Solvent

Clean Cycles 0

Clean Volume (%) 0

Wash Penetration (mm)

Fill Speed 100

Pullup Delay (ms) 0

Eject Speed 100

Rinse time (sec) Final Needle Clean Time

33 RINSE_INJ Wash Station Final Wash Solvent

Injector Inject to

Needle Gap (mm) Needle Gap for Vlv Cleans

Rinse Times (s) Final Valve Clean Time

34 END

35 MOVETO_OBJECT Object Name Home

Index 1

Penetration (mm)

36 LOCK_TERMINAL Terminal locking Off

Table A-5 Parameters and Values for the microLC200-Injection-Rev B Autosampler 
Method  (Continued)

Step Step Name Parameter Value
Operator Guide Eksigent MicroLC 200 Plus System

RUO-IDV-05-1129-B | D5033433 G  125 of 140



Principles of Operation
Eksigent MicroLC 200 Plus System Operator Guide

126 of 140 RUO-IDV-05-1129-B | D5033433 G



B
System Specifications
Table B-1 Eksigent MicroLC 200 Plus system Specifications

Dimensions 71 cm x 64 cm x 59 cm (H x W x D)

(28 inches x 25 inches x 20 inches) 

Weight 25 kg (55 lbs)

Pump electrical • Input line voltage:100 V to 240 V AC

• Input line frequency: 50/60 Hz

• Input current: 4 A

Autosampler electrical • Input line voltage:100 V to 240 V AC

• Input line frequency: 50/60 Hz

• Input current: 4 A

• Output voltage: 36 V DC

• Output current: 4.16 A

Maximum pressure 10 000 psi

Flow rate range 5 µL/min to 200 µL/min

Flow rate precision <0.5% RSD @ 150 µL/min (0.01 min for a 2 
minute run)

Sample capacity • 6 positions for trays or microtiter plates

• 54 2 mL vials/tray

• Microtiter plates:

• Standard depth 96-well 
• Deep 96-well
• 384-well

Injection valve • 1/32 inch connection with port-to-port 
volume <60 nL

• Maximum pressure 10 000 psi

• 316 stainless steel with proprietary coating

Injection volume • Minimum volume: 15 nL (see note below) 

• Maximum volume: 10 µL (or loop volume)

Injection reproducibility • Full loop: <1% RSD

• Partial loop: <2% RSD

Sample carryover 0.01% to 0.005%

Sample cooling temperature range 4°C to 40°C

Gradient delay volume 1 µL to 3 µL

Column oven temperature range +5°C to 80°C

Column length 3 cm to 10 cm
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System Specifications
Cycle time <45 sec

Wetted parts 316 stainless steel, PEEK, PEEKsil, fused 
silica and FEP

Instrument control Eksigent control software with plug-ins for:

• AB SCIEX Analyst® software

• Thermo Scientific Xcalibur software

Note: Minimum injection volume is dependent on the flow rate. For a metered injection, 
very small injection volumes require a slower flow rate. To calculate the minimum 
injection volume, multiply the flow rate by 2.5. The result is the injection volume 
expressed in nL.

Table B-1 Eksigent MicroLC 200 Plus system Specifications (Continued)
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C
Spare Parts and Accessories
View and Order Spare Parts

View the Parts List for the Eksigent MicroLC 200 Plus System

1. Go to www.eksigent.com/downloads/product-catalog. 

2. Click Download our parts and consumables catalog.

Order Parts

1. Go to www.eksigent.com/company/contact-us.

2. Click your location on the map to view contact information for your region or country.

System Accessory Kit
Part numbers marked with * are also available individually.

Table C-1 Accessory Kit Contents (PN 5017802 Rev. H)

Part Number Description Quantity
5015766 Solvent pan 1

5016413* Stainless steel union, hex, 6-32 FxF, 0.15 mm bore 2

5017651* Tubing, mobile phase, 1/8 inch x 3 feet 3

5017797* Bottle, seal rinse, 2 inch diameter 1

5017798* Loop, 2 µL, 1/32 inch PEEKsil, no fittings 1

5017799* Loop, 5 µL, 1/32 inch PEEKsil, no fittings 1

5017800* Injection valve waste tube assembly 1

5017801* Mixer-to-valve tube assembly 2

5018262* Eksigent MicroLC Systems calibration kit 1

5018474* Autotuning tube 2

5019820* Adapter ferrule for 1/32 inch tubing in a 1/16 inch port, 5-pack 5

5019821* Nut for adapter ferrule, 5-pack 5

5023797 Syringe needle guide 3

5024174 Nut, gold plated with 6-32 threads, 3/16 inch 10

5026646 Eksigent control software v. 4.1 CD 1

100-00549 Screw, stainless steel with 6-32 threads, 3/16 inch 4

100-00567* Wrench for 1/32 inch and 1/16 inch nuts 2

200-00329 Mobile phase filter with 10 µm frit 3

200-00342* Column fitting, 6-32 threads 10
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Spare Parts and Accessories
Consumables Kit

200-00356 Wrench, nut extender tool 1

200-00388 Microfilter 1

205-00040 Tubing, PEEKsil, 50 µm ID, 1/32 inch OD, 30 cm 2

205-00041 Tubing, PEEKsil, 50 µm ID, 1/32 inch OD, 50 cm 2

205-00049 Tubing, PEEKsil, 50 µm ID, 1/32 inch OD, 75 cm 2

205-00054* Loop, 10 µL, 1/32 inch PEEKsil, no fittings 1

205-00069 Tubing, PEEKsil, 50 µm ID, 1/32 inch OD, 10 cm 4

205-00070 Tubing, PEEKsil, 50 µm ID, 1/32 inch OD, 5 cm 2

205-00089 Tubing, PEEKsil, 25 µm ID, 1/32 inch OD, 5 cm 2

205-00091* Tubing, PEEKsil, 25 µm ID, 1/32 inch OD, 10 cm 4

300-00019 Tubing, polyethylene 1/4 inch OD, 0.17 inch ID 10

300-00036 2 mL vials 10

300-00037 Snap caps for 2 mL vials 10

400-00465 3 meter USB cable 1

500-00779 Stop block 1

615-00025 Divided utility box 1

620-00071 Blue 54-vial plate 1

700-00050 Pump-autosampler (HT-CTC) interface cable 1

801-00067 Bottle, 250 mL with gray cap 2

805-10100 HALO fused C18 column, 5 cm, 2.7 µm, 500 µm ID 1

910-00070 Low pressure fittings, 5-pack 1

910-00087* Ferrule, stainless steel 1/32 inch, 10-pack 1

Table C-2 Consumables Kit Contents (PN 5032078 Rev. A)

Part Number Description Quantity
5016413 Stainless steel union, hex, 6-32 FxF, 0.15 mm bore 2

5017798 Loop, 2 µL 1/32 inch PEEKsil, no fittings 1

5017799 Loop, 5 µL, 1/32 inch PEEKsil, no fittings 1

5017800 Injection valve waste tube assembly 1

5017801 Mixer-to-valve tube assembly 2

5018262 Eksigent MicroLC 200 Plus system calibration kit 1

5018474 Autotuning tube 2

5019820 Adapter ferrule for 1/32 inch tubing in a 1/16 inch port, 5-pack 1

Table C-1 Accessory Kit Contents (PN 5017802 Rev. H) (Continued)

Part Number Description Quantity
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Spare Parts and Accessories
Upgrade Kit
Contains fittings and other items to upgrade an older ekspert™ microLC 200 system to an 
Eksigent MicroLC 200 Plus system.

5019821 Nut for 1/32 inch to 1/16 inch adapter ferrule, 5-pack 1

5023797 Syringe needle guide 3

5024174 Nut, gold plated with 6-32 threads, 3/16 inch 10

5031383 Autosampler needles, 3-pack 1

100-00567 Wrench for 1/32 inch and 1/16  nuts 1

200-00329 Mobile phase filter with 10 µm frit 3

200-00342 Column fitting, 6-32 threads 10

200-00356 Wrench, nut extender tool 1

200-00373 Filter capsules, 2-pack 1

200-00388 Microfilter 1

205-00040 Tubing, PEEKsil, 50 µm ID,1/32 inch OD, 30 cm 2

205-00041 Tubing, PEEKsil, 50 µm ID,1/32 inch OD, 50 cm 2

205-00049 Tubing, PEEKsil, 50 µm ID, 75 cm 2

205-00069 Tubing, PEEKsil, 50 µm ID,1/32 inch OD, 10 cm 4

205-00070 Tubing, PEEKsil, 50 µm ID, 1/32 inch OD, 5 cm 2

205-00089 Tubing, PEEKsil, 25 µm ID, 1/32 inch OD, 5 cm 2

205-00091 Tubing, PEEKsil, 25 µm ID,1/32 inch OD, 10 cm 4

615-00025 Divided utility box 1

910-00070 Low pressure fittings, 5-pack 1

910-00087 Ferrule, stainless steel 1/32 inch, 10-pack 1

Table C-3 Upgrade Kit Contents (PN 5031861 Rev. D)

Part Number Description Quantity
5023797 Syringe needle guide 3

5024174 Nut, gold plated with 6-32 threads, 3/16 inch 10

5028466 50 µm ID electrode for AB SCIEX Turbo V™ ion source 1

5028467 25 µm ID electrode for AB SCIEX Turbo V ion source 1

5028658 C18 guard column 1

5031383 Autosampler needles, 3-pack 1

5036153 Front panel label 1

200-00388 Microfilter 1

205-00070 Tubing, PEEKsil, 50 µm ID, 1/32 inch OD, 5 cm 4

Table C-2 Consumables Kit Contents (PN 5032078 Rev. A) (Continued)

Part Number Description Quantity
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Spare Parts and Accessories
Replacement Parts

205-00089 Tubing, PEEKsil, 25 µm ID, 1/32 inch OD, 5 cm 4

910-00087 Ferrule, stainless steel 1/32 inch, 10-pack 2

Table C-4 Replacement Parts for the Eksigent MicroLC 200 Plus System and HTC-xt PAL 
Autosampler

Part Number Description
Column Oven

5015996 Mounting kit for mounting column oven on Turbo V and DuoSpray™ ion 
sources

5020904 Column oven

Electrodes and Related Accessories
5028466 50 µm ID electrode for AB SCIEX Turbo V ion source

5028467 25 µm ID electrode for AB SCIEX Turbo V ion source

5029303 Union for grounding 65 µm ID electrode

5029342 65 µm ID electrode for AB SCIEX Turbo V ion source

800-00455 65 µm ID electrode for AB SCIEX API 2000 source

5032057 Replacement emitters for 50 µm ID electrodes

5032058 Replacement emitters for 25 µm ID electrodes

5028470 Tool for replacing electrode emitters

Guard Columns and In-line Filter Parts
5028658 C18 guard column

5028659 C8 guard column

200-00373 Filter capsule (2-pack)

200-00388 In-line filter assembly (includes 5 filter capsules)

205-00089 Tubing, PEEKsil, 25 µm ID,1/32 inch OD, 5 cm

Injection Valve Parts
5014843 Injection valve assembly

5019104 Injection valve assembly, without pod

5019105 Injection valve motor

200-00326 Injection valve rotor seal

200-00327 Circuit board for valve assembly

200-00417 6-port injection valve and fittings

200-00452 6-port injection valve pod and fittings

Table C-3 Upgrade Kit Contents (PN 5031861 Rev. D) (Continued)

Part Number Description Quantity
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Spare Parts and Accessories
Other Parts
200-00327 PCB, Express Ultra valve

700-00028 Control cable

801-00084 AB SCIEX interface kit, includes electrode, MS interface cable, grounding kit, 
column oven mounting kit, clamp and rods

Sample Loops
910-00081 Loop, 1 µL, PEEKsil

200-00367 Loop, 2 µL, stainless steel

5016578 Loop, 10 µL, 1/32 inch OD stainless steel, no fittings

5016279 Loop, 20 µL, 1/32 inch OD stainless steel, no fittings

SL50NW Loop, 50 µL (do not use included fittings)

SL100NW Loop, 100 µL (do not use included fittings)

Syringe and DLW Parts
4460827 Replacement plungers for DLW syringe (PN  4460861) 10-pack

4460861 Syringe for HTC-xt PAL autosampler DLW option; removable needle not 
included.

4460863 Plunger holder for plunger for DLW syringe (PN 4460827)

4460866 DLW holding loop and needle adapter

4460868 Flow diverter

5031383 Autosampler needles, 3-pack

Tubing and Fittings
5019621 Fitting, 6-40 threads, 1/32 inch, 10-pack

910-00089 Fitting, PEEK, red, non-conductive (PN  200-00330) 10-pack

200-00252 Fitting, polypropylene, flangeless tube-end, 1/16 inch OD

910-00085 Nut, stainless steel, 1/32 inch OD for 6-40 threaded columns, 10-pack (use 
with ferrule PN 910-00087)

5108305 Tubing, FEP, 3/100 inch ID, 1/16 inch OD 

200-00061 Tubing, PEEKsil, 75 µm ID,1/32 inch OD, 30 cm

5018306 Tubing, stainless steel, 1/10 inch ID, 1/32 inch OD, 5 cm

Table C-4 Replacement Parts for the Eksigent MicroLC 200 Plus System and HTC-xt PAL 
Autosampler (Continued)

Part Number Description
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Revision History
Revision Reason for Change Date
 D5033433 A First release of the document. March 2012

D5033433 B Revised to include higher resolution pictures. March 2012

D5033433 C Restructured and added information to the Routine 
Maintenance chapter. Added troubleshooting 
information.

September 2012

D5033433 D Added procedures for adding a new mobile phase, 
moving to a new computer, flushing and sonicating 
electrodes, and configuring the autosampler. Also 
added tips for handling PEEKSil tubing, sample 
preparation guidelines, and explanation of injection 
modes. Updated example experiment to add method 
for flushing electrode. In Appendix A, made 
corrections to equations and added information about 
the sample position in the loop.

June 2013

D5033433 E Updated part numbers for electrodes and guard 
columns. Updated image showing Eksigent control 
software driver utility. Deleted instructions for 
installing the Method Merger Tool software. Used 
consistent terminology for column oven.

October 2013

D5033433 F
RUO-IDV-05-1129-A

Added procedure for testing the DLW. Updated 
plumbing instructions and figure. Updated procedure 
for calibrating flowmeters. Updated contents of 
accessory and consumables kits and added upgrade 
kit and additional spare parts. 

February 2014

D5033433 G
RUO-IDV-05-1129-B

Updated to incorporate MicroLC 200 Plus. Updated 
legal page and manufacturer’s address. Corrected 
electrode part numbers in Figure 4-2 and Table C-4. 
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Updated Table C-4.

September 2014
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Index
A
AB SCIEX TripleTOF Systems

modifying calibration method template 82
accessory kit contents 129
acquisition batch

creating 39
submitting 39

acquisition information, viewing 47
acquisition method, creating 34
adding time to a run 47
Analyst software hardware profile

creating 19
troubleshooting issues after a move 88
verifying 16

AutoCalPos.dam file 84
autosampler

configuring 77
electrical specifications 127
fuse, replacing 70
training 77
tray type, setting 81
troubleshooting 100

autosampler method
parameters 37, 116
selecting 36, 42
viewing 43

B
backflushing clogged electrodes. See flushing

C
calibrating

flowmeters 54
TripleTOF systems 82

calibration method template 82
LC method for 83
updating 84

CDS on AB SCIEX TripleTOF Systems 82
column heater. See column oven
column oven

enabling 25
specifications 127
troubleshooting 99

column, plumbing 61

conserved flow mode 27
consumables kit contents 130, 131
contact information 12

D
dimensions 127
Direct Control dialog, opening 47
disposal

of chemical waste 50
of electrical and electronic equipment 11

DLW actuator, verifying 72
DLW pump, testing 71
documentation, additional 12
dynamic flow control 107
dynamic load and wash 111

E
Eksigent control software

getting help 41
moving settings to a new computer 86
performing a run 41

electrical specifications 127
electrode assemblies 65
electrodes

flushing 66
guidelines for selecting 109
sonicating 69

F
flow control system, troubleshooting 96
flow mode

conserved 27
independent 27
setting 30, 33

flow rate
available configurations for system 13
calculating 104
dependency of minimum injection volume

on 128
guidelines for setting 107
measuring 54
setting 30, 33
viewing 46

flow stability diagnostic 56
flow velocity 107
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Index
flowmeters, calibrating 54
fluid connections, testing 94
flushing

electrodes 66
injection valve 24
system 22

fuse, replacing 70

G
gain and integral settings 89
gas parameters for the acquisition method 35
guard column 16, 132

H
hardware profile

creating 19
verifying 16

I
independent flow mode 27
injection modes

metered 29
rapid 30
standard 29

injection port
plumbing 61
position, configuring 79
replacing 57

injection valve
flushing 24
plumbing 61
pod, replacing 59
rotor seal, replacing 58
sample loop, replacing 57
specifications 127
troubleshooting 100
waste position, configuring 79

injection volume
dependency on flow rate 128
guidelines for setting 107
minimum 128
specifications 127

in-line filter 16, 132

L
LC method

creating 27, 42
for calibration method template 83
for flushing electrode 32

selecting 37, 38

M
maintenance schedule 49
metered injection mode 29
microfluidic flow control 104
microLC200-Injection-Rev B autosampler
method

parameters 116
selecting 36

mobile phases
adding a custom 23
purging 51
selecting 21

monitoring a run 40, 45
moving to a new computer 86
MS acquisition method, creating 34
MS acquisition, starting 39

N
needle penetration depth

setting for a vial 81
setting for the injection valve 80
verifying 80

needle, replacing 75

P
parts

ordering 129
spare 129

pausing a run 47
PEEKsil tubing, best practices 62
plunger, replacing 74
pod, replacing 59
power up 41
pressure

calculating 105
testing system 94
viewing 46

pressure transducers, re-initializing 52
pump

electrical specifications 127
seal rinse, replacing 52

purging mobile phases 51

R
rapid injection mode 30
regulatory compliance 10
rotor seal, replacing 58
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Index
run
changing duration 47
monitoring 40, 45
pausing 47
starting 39, 45
stopping 46, 47
using Eksigent control software 41
using the Analyst software 16
viewing status during 46

run table
creating 42
explanation of row color 45

S
safety

instructions 8
standards 10

sample loop
position of sample inside 114
replacing 57

sample preparation guidelines 15
seal rinse, replacing 52
shorten a run 47
solvents, replacing 69
sonicating a clogged electrode 69
source and gas parameters 35
specifications 127
stack holder

setting temperature 70
tray holder position, configuring 77

standard injection mode 29
starting a run 39, 45
stopping a run 46, 47
storage instructions 91
symbols and labels 11
syringe

barrel, replacing 73
needle, replacing 75
plunger, replacing 74

system
accessory kit 129
accessory options 14
consumables kit 130, 131
dimensions 127
equilibrating 26
fluid connections, testing 94
flushing 22
inspecting 50
moving to a new computer 86

powering up 41
pressure testing 94
spare parts 129
specifications 127
storing 91
symbols and labels 11

T
technical support, obtaining 12
theory of operation 103
traces in Eksigent control software

adding or removing 48
changing appearance of 48
zooming in and out 47

tray holder position, configuring 77
troubleshooting

autosampler 100
column oven 99
flow control system 96
injection valve 100
moving to a new computer 88
system initialization 96

tubing
best practices for PEEKsil tubing 62
guidelines for selecting 109

U
user guides, additional 12

V
valve. See injection valve
valve pod, replacing 59
valve rotor seal, replacing 58
verifying

DLW actuator 72
hardware profile 16
needle penetration depth 80

W
wash solvents, replacing 69
wash station position, configuring 78
waste disposal

chemical 50
electrical and electronic equipment 11

weight 127

Z
zeroing pressure transducers 52
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